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WARRANTY AND EXTENDED SUPPORT 
 

THIS SHENZHEN ATTEN ELECTRONICS CO., LTD. PRODUCT IS WARRANTED. 

We warrant the quality for the period of two years from purchasing date, so please contact either 

SHENZHEN ATTEN ELECTRONICS CO., LTD. directly or the dealer where the instrument is purchased 

as possible for the details of the warranty service or repair in this period. 

 

 

 

 

EXTENDED SUPPORT 

 
Please read this manual before use this instrument and especially note below items. 

1. Know well the management and using of this instrument based on details of Manual before use 

it. 

2. Make sure before connect if the selected input voltage (220V) of this instrument is same 

as the power voltage. 

3. Make sure correct fuse of rated voltage is used (AC 250V，1A). 

4. Shall do the installation and check depend on Manual. 

5. SHENZHEN ATTEN ELECTRONICS CO.，LTD. will not be responsible for the below case. 

   1) In case of the damage due to misuse or careless use, and in case of modification of 

performance. 

   2) In case of exceeding the warranted period(Only, in this case, we do the parts supply for 

value or repair for value, and the period of opposite view is for 5years after finish 

the warranted. 
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CHAPTER 1 INTRODUCTION 

1. GENERAL INFORMATION 

AT3200 Antenna experiment system consists of Propagation Pattern and Gain of Antenna, and 

there is each different Antenna of 10types according to the driving style. 

In this RF Source Unit supplying RF current of 500MHz, 2GHz, 10GHz and Controller which 

can control the direction of antenna, in addition the software which can do a simulation of 

antenna copying pattern and characteristics by pc interface is offered. 

Since this Antenna Trainer makes the using frequency to be high, it is possible to experiment 

on characteristic of antenna propagation in narrow space (some 100m'). Also moving and custody 

of System are easy. Especially, since consists of transmitting & receiving antenna of 

telecommunication repeater and the antenna used for receiving of artificial satellite mainly, 

the more practical training is possible. In particular，for Dipole or Yagi Antenna. The number 

and spacing of Element is controlled, you can design yourself for directional characteristic 

and gain. 

 
Figure 1-1 Flow Chart for Experimental Device on Antenna 

 

2. NOTES 

1. Please check the driving procedure and the input power used for this Instrument，after 

read this book before use it. 

2. Please check if connect AT3200A (Main Controller) to Motor Control Cable of AT3200C(Receiver) 

before turn on. 

3. Avoid operation or storage of the instrument within 3m existed the reflector from the antenna 

of transmitter and receiver. 

4. Make the antenna to run using the main controller or PC surely. 

5. Don't make to stop by physical power when the antenna of receiver runs. 

6. The input voltage of AC is 220V exclusive use. 

7. Avoid storage of the instrument in humid area. 
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3. ATTACHMENTS 

Please check if there are below attachments When open this pack after purchase the instrument. 

(1) AT3200A (Main Controller) 

    - Main Controller                  - 1 

    - PC Connecting Cable (2m)         - 1 

    - Motor Control Cable (lm)         - 1 

    - User's Manual                    - 1 

  (2) AT3200B (Transmit Unit) 

      - Body                        - 1 

(3) AT3200C (Receive Unit) 

      - Body                       1 

(4) AT3200D (Antennas) 

- See Table 1-1 

 

4. NAME OF EACH PARTS 

1) MAIN CONTROLLER 

    Below figure is a Main Controller. This is divided into a receiver and transmitter. At first, 

the left receiver consists of Signal Level, Window displaying the revolving angle, power 

Switch, BNC Type jack, Switch controlling the revolving direction (CW, CCW) and Step 

Controlling Switch. 

 

Figure 1-2 Main Controller 

 

1. POWER SWITCH (Main Power On/Off SWITCH) 

2. SIGNAL INTENSITY DISPLAYER (-50dB -- -10dB) 

3. REVOLVING ANGLE DISPLAYER (0°- 360°) 

4. 500MHz，2GHz，10GHz OSCILLATION ON/OFF SWITCH & LED 

5. MODULATION SWITCH (MODULATION On/Off SWITCH) 

6. 500MHz FINE ADJUSTMENT SWITCH (480MHZ ~ 650MHz) 

7. 2GHz FINE ADJUSTMENT switch (1.85GHZ - 2.35GHz) 

8. 10GHz OSCILLATION OUTPUT TERMINAL 

9. 2GHz OSCILLATION OUTPUT TERMINAL 

10. 500MHz OSCILLATION OUTPUT TERMINAL 
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11. STEP SWITCH (1°/ 5°/10°) 

   12. ORIGIN SWITCH 

   13. ANTIDIRECTION ROTATING SWITCH 

   14. NORMAL DIRECTION ROTATING SWITCH 

   15. 1kHz SIGNAL INPUT TERMINAL 

 

 

2) TRANSMITTER 

 

   Figure 1-3 Transmitter 

3) RECEIVER 

 

 
Figure 1-4 Receiver 

4) ANTENNA FOR TYPE 

The antenna can be divided into 500MHz, 2GHz and 10GHz usages generally. 
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Figure 1-4 Antenna for Each Kind 

Using 

Frequency 
Antenna Type 

Quanti

ty 

Dipole Ant.  l ea 

Folded Dipole Ant.          l ea    

Yagi Ant.  2ea 

Monopole Ant  1ea 

Drooping Ant  1ea 

Circular Loop  1ea 

Square Loop  1ea 

500MHz 

Diamond Loop 1ea 

Dipole Ant  1ea 

Spiral Ant  1ea 2GHz 

Monopole Ant 1ea 

Helical Ant 1ea 

Horn Ant  2ea 

Rectangular Patch Ant 1ea 

MicroStrip Planar Array Ant(Rectangular) 1ea 

10GHz 

MicroStrip Planar Array Ant(Circular) 1ea 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 7 

CHAPTER 2 INSTALLATION & EXECUTION OF PROGRAM 

 

1.INSTALLATION OF PROGRAM 

Operate [Execution] of Start Menu in Windows or execute the program Setup.exe in λ/2 of Setup 

Program diskette using  [Searcher] . Only, have to terminate the other executing program before 

execute the installation program. In directory setting screen as below, select the install object 

folder users want in setting screen or click the Finish button. 

 

Figure 2-1 

After some time, below screen of file copying procedure is output. If click Cancel in this time, 

all install works are canceled. 

 

Figure 2-2 

If the message "Please insert disk number2" is displayed on route install, insert disk2/2 and 

click the OK button. 

 

Figure 2-3 

If the install is completed, the below screen is displayed. Select OK here, all install work 

is completed. 
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Figure 2-4 

After some time below folder is generated automatically. If click the icon AT3000 Antenna 

Experiment System, program is executed. Click the icon AT3000 Antenna Experiment System to delete 

the program. 

 

Figure 2-5 

If the install is completed the files related to execution and below the low folder of 2type 

are generated in the folder appointed by user(Default is Antenna) and its details is as below. 

  - Sample：Sample Pattern 

  - Images：Antenna Picture for each type 

- AT3000：Folder which data to be saved when experiment. 

 

2. EXECUTION 

1) PROGRAM USED FOR ANALYSIS 

 

2) PROGRAM USED FOR DATA ACQUISITION 
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For the fine information, see Experiment in Chapter 3 
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CHAPTER 3 BASIC STUDY & EXPERIMENTS 
 

EXPERIMENT 3-1 HALF-WAVE(λ/2) DIPOLE ANTENNA 

Let's measure the radial pattern about E Plane and H-Plane for λ/2dipole antenna used for 500MHz 

in this experiment. We will study a polarization characteristic of dipole antenna. Let's 

calculate the antipower beam width ofλ/2 dipole antenna. 

 

BASIC STUDY 

  1. RESONANCE OF LEAD 

  Though very short lead, if the high frequency current flow, it makes a difference radial 

efficiency but the electromagnetic wave in proportion to the current strength. The question 

is how make to flow the optimum current to a lead.   

The current flow into a lead of high frequency open both end,  

In the frequency f0, occurred a resonance phenomenon alike LCR  

direct current of (B). 

 
 Figure 1-1 Antenna and Resonance Circuit 

As Figure 1-1(A), connect the high frequency galvanometer in the center of direct lead of 

suitable length L. 

Set the frequency in low and make to high it slowly, the current begins to flow into an antenna. 

As make the frequency to be increased continuously, the current of antenna increase gradually 

so like Figure it to be maximum at some frequency f0. And make it higher and the current is 

to be decreased oppositely. 

It can know that the relation between frequency and antenna current alike LCR direct resonance 

characteristic in Figure(B). Accordingly it can be shown that both end is opened and the lead 

to be center power feed resonant at frequency f0. In this time the length of lead is about 

1/2 of f0 wave. 

Why does the lead of length / resonant with a high frequency has double wave length. It can 

be thought as below. 

As Figure 1-2, the high frequency current travel along lead to vertical direction A by the 

high frequency e(t) to be power feed at lead O point. This is called a traveling wave, the 

traveling speed is same as electric wave spread through space. The current arriving a lead 

terminal point A is reflected by ∞ impendence completely and return to power along lead. This 
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is a reflected wave. 

Therefore the traveling wave and reflected wave transmitted from power continuously are 

existed on the lead. Now set a frequency of power in a resonance frequency, the traveling 

wave and reflected wave are to reciprocated on a one lead like O-A(or O-A') as below. If the 

polarity of power is inversed fitted when the reflected wave return to power the traveling 

power and flected wave on lead become stronger. 

The relation between a length of lead l and resonance frequency fo in this time become 

            …（1-1） 

 

Figure 1-2 The reason that the electric wave of wave 3 resonate to lead λ/2 

 

2. The Excitation of Antenna 

If the lead is to resonate, the traveling wave and reflected wave of same size is occurred 

on the lead, and the voltage and current on lead become as Figure 1-3 with occurring a 

interference each other by these.  

Figure shows the size of each voltage and current, and the voltage becomes maximum in the 

center and minimum in both ends. Also voltage is opposite to current, maximum in both end 

and minimum in the center.  

 

Figure 1-3 Voltage Current Distribution on both end open λ/2 lead 

Since the standing wave was occurred a standing wave on lead the size of voltage and current is to set 
according to position. As a on-board antenna is a means to flow high frequency current into a lead makes this 
standing wave to be occurred on lead. Figure 1-3 shows that one standing wave is occurred in the lead ofλ/2 
length.  

In Figure1-1 if the frequency of power make to be 2times, 3times… of resonance frequency f0. How it will 
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become.  
As for f0. Theλ/2 lead is to be λ for 2f0, and to be 3λ/2 for 3f0 anything become integral multi λ/2. 

Figure 1-4 shows voltage and current distribution on lead. 
The resonance frequency of LCR direct current but (On experiment, it isn't one. In the specific multi-frequency 
the resonance can be occurred.) In the case of lead, in some integral multi frequency the resonance is occurred 
for the lower resonance frequency f0. Here f0 is named a basic frequency of lead or inherent frequency, and 2f0, 
3f0 … is named harmonics resonance frequency. The case of using the lead of antenna by resonating with high 
frequency is named high frequency excitation. 

 

The leads of constant length resonate with integral multi high frequency of inherent frequency f0. 

Figure 1-4 High Frequency Excitations of Harmonics 

For the voltage and current distribution on lead, current is minimum and voltage is maximum 

at both end, and current is maximum and voltage is minimum at point of distanceλ/4, and it 

is inversed by periods of λ/4. The maximum point of voltage (or current) is named the anti-node, 

minimum point named the node. In case of exciting the antenna lead with a standing wave, Figure 

1-5 shows the method to connect to the current anti-node and voltage anti-node, and that is 

named the current power feed and this is named the voltage power feed. 

 

Figure 1-5 Current & Voltage Power Feed of Antenna on Both End Open of 

 Length λ/2, λ/3 ，λ2 and the Voltage & Current Distribution 
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Figure 1-6 Dipole Antenna           Figure 1-7 (A) Center Feed Half Wave Doublet 

(B) Half Wave Doublet is a Assembling of 

Major Infinitesimal Antenna of Different Size 

In Figure 1-5 indicating the current direction  in  some time it have to be considered that 

the current direction of standing wave adjoining each other becomes inverse(180°anti-phase) 

and that the voltage and current distribution become different according to a point of power 

feed. 

As an example, Figure (B) and Figure (E) is all high frequency antenna of length λ but 

the current direction and voltage polarity on lead is to differ, and the radiation characteristic, 

especially the directivity is to differ entirely because of the position of power feed point 

is different. 

3. HALF-WAVE DIPOLE 

As this antenna is a useful one of the simplest structure, it is called a half-wave doublet 

or dipole simply. The doublet (or dipole) means a electric dipole, and in case of a voltage 

distribution in Figure1-6, means what the left and right of lead become a constant and 

nonoscillatory charge according to the polarity of power. 

The standard of half-wave dipole is what does center feed in Figure 1-7(A).This is called a 

center fed dipole. 

In the case of the thickness of lead is very slim in comparison with wave, the current 

distribution becomes sine wave as the dotted line in Figure 1-7(A), It can see an assembling 

of a infinitesimal antenna. Therefore the radial field strength of half-wave dipole can be 

calculated with an assembling of infinitesimal antenna. and for the maximum strength of right 

angle direction with lead, when the current of power feed point is I(A), it becomes  

 

R is isolated distance [km] from antenna. 

The directional characteristic of half-wave dipole is almost similar to the infinitesimal 

antenna, it becomes a shape 8 and shape of cubic donuts. 

 

Figure 1-8 Field Directivity of Half-Wave Dipole(side y ^ z) 
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For the comparison, indicate the directivity of infinitesimal antenna with dotted line. 

Some is 1 at maximum direction but as a matter of fact, in case of half-wave dipole, it is large 

as 1.045times. The cubic directivity becomes more flatter than infinitesimal antenna rotating 

around the axis Z. 

 

The radial resistance of this half-wave dipole antenna is calculated like a case of 

infinitesimal dipole as below and  

 

the value is 73.13Ω. 

In case of center feed, as the feed point is a maximum current point, the radial resistance 

73.13Ω is a simulated load resistance consuming the power as same as radial power in point 

of power, and if ignore the high frequency resistance on lead, it becomes same as the resistance 

of input impedance. When the length of lead is justλ/2 of wave in free space the radial power 

in above formula(numerator) divided into a effective power and ineffective power, and 

ineffective power is to display a reactance for power as a condenser or coil, and the value 

is 42.55Ω in inductive. Accordingly the radial impedance of half-wave dipole becomes 

       Resistance Element              73.13.Ω 

       Reactance Element              42.55Ω(Inductive)  

Like following formula 1-3, show the field strength of maximum radial direction to the 

required formula in the radial powr Pr. 

           ……（1－3） 

Therefore, substitute the value of current for the formula 1-2 and becomes 

                     ……..（1－4） 

 

（A）Infinitesimal Antenna    (B) λ/2 Dipole    (C) λ/2 Dipole Effective Wave 

Figure 1-9 The field strength at right angle direction with lead 

  is proportioned to the area of oblique side. 

It was explained already that the field strength(maximum radial direction) of infinitesimal 

is proportioned to the volume of current and length flowing into lead (See Formula 1-2). The 
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volume Il of current I[A] and length l[m] is a size corresponding to the area S of oblique part 

as indicated in Figure 1-9(A). Only the unit isn't [m2] but [m . A], If use this S the field 

strength of infinitesimal antenna becomes from the formula 1-4. 

                        ……（1－5） 

As the half-wave dipole is the assembling of infinitesimal antenna, rightly it will proportioned 

to the area S of oblique part in the same Figure(B). But the size of flowing current isn't definite, 

and the size of current is changed with sine wave in this case therefore it is difficult to 

indicate with the area S but if indicate the result, becomes 

        ……（1-6） 

 

 and you can see that this area S becomes same size as a globular part in Figure(C). The length 

of lead direction of this globularity le is 

                ……（1-7） 

and this le is named the effective wave of half-wave dipole. 

The field strength at right angle direction with the lead of half-wave dipole is same as a current 

of anti-node and becomes same as the antenna flowing definitely through the length ,λ/3.14 

in Figure 1-9(C). The antenna like this is to keep away from the condition of infinitesimal 

antenna 1< λ but substitute S got in the effective wave of half-wave dipole in Formula 1-5 

and becomes 

     ……（1-8） 

and accord with Formula 1-2. 

As above the field strength at right angle with lead is settled by current according to the 

lead and volume S of length.  

As Figure 1-5, the antenna excited by harmonics which the length of lead is to multi-integer 

of ,λ/2 is named Harmonics Antenna. As an example when use the half-wave dipole in 2GHz used 

for 500MHz, it becomes harmonics antenna of 4times. 

Figure 1-10 shows a directivity in free space of harmonics antenna of 2-4times.To illustrate 

the directivity of harmonics antenna in free space, use generally this method as follows. Make 

the current of current anti node to same size for each antenna, and draw by making the maximum 

radial direction of half-wave dipole to 1 for the easy' to compare with half-wave dipole. Figure 

shows only the right directivity of lead, surely left is same shape and the actual cubic 

directivity becomes a complex cubic forming when rotate in axis of lead. 



 16 

 

Figure 1-10 Directivity of Half-Wave, Full-Wave and Harmonics 

As the multip]e of harmonics is increased in Figure, the direction growing the maximum radiation 

get near to the direction of lead, and indicate the relation between the spacing angle and length 

in Figure 1-11. Also Figure 1-10 shows the directivity of center power feed antenna of l wave, 

by the way this antenna becomes same shape as right and left sine wave current. Therefore it 

isn't named harmonics antenna but full-wavelength (l wavelength) since the maximum radiation 

is occurred to right angle direction with lead.  

Redial Resistance of Harmonics Antenna(Current Anti-Node) becomes 

2Times－90Ω，3 Times－100Ω，4 Times－114Ω 

5 Times－121Ω，6 Times－126Ω，7 Times－131Ω 

 
Figure 1-11 Relation between Lenth of Harmonics Antenna  

and Maximum Radial Direction 

 

 

 

 

 

 

 

 

EXPERIMENT PROCEDURE 
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SETTING OF EXPERIMENT APPLIANCE 

1. Set the main controller, transmitting & receiving antenna positioner and computer which are 

main appliance of antenna experiment set. 

2. Set the height controlling bar of a transmitter and fix the 500MHz Yagi antenna fixed on 

antenna fixing pack to the polarization control plate attached a controlling bar. And set 

the antenna at a level with ground to get a even polarized characteristic. The transmitting 

antenna set as Figure 1-12 has even polarized characteristic. 

 

Figure 1-12 Setting of Even Polarized Transmitting Antenna 

  Set OFF the oscillation switch for frequency in a transmitter of a main controller, and connect 

the 500MHz oscillation output terminal and a Yagi antenna with a SMA Cable used for 2m. 

3. After set an antenna stationary bar to a transmitter, fix a dipole antenna to a polarization 

control plate attached on a stationary bar. And set an antenna at right angle with ground 

to get a even polarization characteristic, and control the antenna to take place in center 

of a rotating axis of receiver using two control pin. See Figure 1-13 to set. 

 

 Figure1-13 Setting of a Even Polarization Receiving Antenna 

  Connect a dipole antenna and RF IN terminal of receiver with a SMA cable used for lm, and 

connect a OUT PUT(1KHz) terminal of receiver and a Input(1KHz) in receiver of main controller 

with a BNC Cable. 

4. Calculate the length of λ/2dipole in 500MHz and measure a length of actual antenna by using 

below formula, and record in Table 1-1. 

 The exact oscillation frequency of RF signal generator is 500MHz. 
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Table 1-1  The Length of λ/2 Antenna [cm] 

 Length of Antenna Theoretically  Length of Actual Antenna 

λ   

λ/2   

L   

t   

Note : The antenna length has to be decided by considering the ratio between a length of conductor and diameter, 

end effect(load effect in the end of lead) and impedance discontinuity. In this case, the length 

of antenna has to be shorter than λ/2. 

5. As Figure 1-14, the distance between antennas is isolated as r=l.5m. Control the transmitting 

receiving antenna to opposite each other. 

 

Figure 1-14 Distance between Antennas r 

6. Set the oscillation switch and modulation switch for frequency in state of the power is turned 

off as below. 

    - Power OFF 

    - 500MHz Oscillation Switch off 

    - 2 GHz Oscillation Switch off 

    - 10 GHz Oscillation Switch off 

- Modulation Switch (Mod) off 
7. Turn the power of main controller on and set a oscillation switch and modulation switch for 

frequency as below. 

    -Power ON 

    - 500MHz Oscillation Switch on 

    - 2GHz Oscillation Switch off 

    - 10GHz Oscillation Switch off 

    - Modulation Switch (Mod) on 

8. After set as above, execute a experiment appliance program for antenna Execute the exe file 

named Windows AT3200 antenna experiment system. Then below window is generated. Here click 

the data acquisition in pop up menu and set the data acquisition window. 



 19 

 

If below window is set select a antenna type. And do initial state after execute a delete 

screen in edit menu. Then select E-Plane as Plane, and control to be displayed 0 on antenna 

gain displayer by controlling signal attenuation. If the control is completed, click the AUTO 

button to start a data acquisition. 

 

 

9. Finish a data acquisition, save a got radial pattern to file. Use a data box to confirm the 

radial pattern. Set MSP(Maximum Signal Position) to 0°, can see a radial pattern of antenna 

exactly. 

 

10. Set an 500MHz Yagi antenna used for receiving at right angle with ground by rotating  

90°the polarization control plate with spinning a fixing bolt attached to polarization 

control plate to get a even polarization characteristic. 

 

11. Set as Figure 1-16 for the k/2 dipole antenna used for receiving get a even polarization 

characteristic. Here set the antenna at right angle with a rotating axis by loosing the control 

screw and moving the position control plate. 
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Figure 1-15 Setting of a Even Polarization Transmitting Antenna 

 

Figure 1-16 Setting of an even polarization receiving antenna 

 

[Reference] According to the position of a receiving cable, it can be the case that the partial of transmitting 

signal is received through a cable. During experiment the radial pattern; have to control the 

position of connected cable to a receiving antenna to prevent the error by this effect. Have to 

make an effort to maintain a short length of cable connecting the receiving antenna and main control 

period. Have to set to be placed near a mast cable with maintaining symmetry. 

 

12. Keep the drawing pattern of E-Plan, after click again the antenna initial state in the edit 

menu of the software, select H-Plane as Plane, and click the Auto button for a data acquisition. 

Completed the data acquisition,save two pattern to file. 

 

13. Keep  the  500MHz Yagi antenna used for transmitting to get a vertical polarization 

characteristic, and set;λ/2 dipole antenna used for receiving to get a even polarization 

characteristic as Figure 1-17. 

 

14. Click the delete screen in a edit menu of program and after click the antenna initial state, 

click the Auto button for a data acquisition. 

 

15. Observe three radial pattern. Are you expect the third experiment result? Explain. 
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Figure 1 17 Setting of Transmitting and Receving Antenna 

16. Set again each transmitting, receiving antenna to get a vertical polarization characteristic. 

The distance between antennas is r=l.5m. Keep the surroundings of antenna with the first 

experiment. Get E-Plane radial pattern ofλ/2 dipole antenna and save in the Dummy-Plane. 

Theoretically this radial pattern must same as the first pattern if except the properly by 

finding the point which can be generated a reflection. After do properly, experiment 

continuously and save a new pattern in E-plane. 

 

17. Click the data indicate line in the view menu at a upper menu of a data analysis program. 

Two cursor used for E-Plane(Blue, White) and two cursor used for H-Plane(Yellow, Green) are 

appeared. Click the arrow at side of presentation window for each color, the same color cursor 

is moved and the value of a presentation window will be changed. These indicate the position 

angle of cursor and the receiving power in that time as dB, and the difference the angle 

between cursors with power display on below two presentation window. Record in Table 1-2 

the got value in this time. 

Table 1-2 Power of Angle 

Angle 

 
0° 30

°
 60° 90° 120° 150° 180° 210° 240° 270° 300° 330° 

Receiving 

Power of 

E-Plane 

For Angle 

            

Receiving 

Power of 

H-Plane 

For Angle 

            

 

18. Get the angle received the maximum power in E-Plane pattern and the receiving power in that 

time. Click the Maximum Single Level button on E-Plane data window and confirm if it is 

corresponded the measured value and the got maximum value by moving the cursor. And record 

on below Table 1-3. 

   Table 1-3 Comparing E-Plane and Theoretic Value 

receiving 

Power 

 The Value 

using a cursor 

Angle  

Receiving 

Power 

 The Value by Maximum Receiving 

Single Level Icon 

Angle  
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19. Get the half angle of main beam power size in the E Plane pattern. Click the Half Power 

Beamwidth button on the E-Plane window to confirm if it is corresponded the measuring value 

and got value using a cursor.  

Keep in mind what the power is decreased is same as 3dB attenuation. 

                  (l0log0.5=-3dB) 

Calculate the anti-power beam width in E-Plane of a ;t/2 dipole antenna using below formula. 

HPBWE=∣θHPBWeft-θHPBWRIGHT∣ 

HPBWE=                    

If the right and left of HPBW have a angle of “0”，must add 360°to in the formula. 

 

20. Repeat 18times the experiment procedure in the H-Plane radial pattern. 

HPBWH=                    

 

21. Click the data indicating line in a view menu to delete all the cursors. Compare the experiment 

values with the given value in the antenna software. If the calculated result isn't 

corresponded to this  values, experiment and calculate again. (When there are difference 

more T). 

 

22. Save the data of E-Plane and H-Plane and output the results. 

 

23. After pull a cell of dipole antenna of some 5ram, experiment again from No.1 through  

No.22 based on above experiment procedure. Since the object of this experiment is the 

frequency change in accordance with the change of antenna length, the receiving power for 

a 500MHz frequency will be some changed .So record about the difference by comparing with 

former results after experiment former in order once again. 
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EXCERCISE 

1. What'S role of an antenna in telecommunication ? 

                                                                            

                                                                            

2 What's the isotropic source. Also what's this usage? 

                                                                              

                                                                              

3. What's the radial pattern? Explain the difference between the transmitting and  

receiving pattern of an antenna. 

                                                                              

                                                                              

4. Explain about a dipole antenna. 

                                                                              

                                                                              

5. How to divide the radial characteristic of an antenna ? What's the radial pattern of  

a dipole antenna? 
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EXPERIMENT 3-2 FOLDED DIPOLE ANTENNA 

Let's measure the radial pattern about E-Plane and H-Plane for a folded dipole antenna in this 

experiment. We will study the radial characteristic of a folded dipole antenna. Let's calculate 

the anti-power beam width of a folded dipole antenna using an antenna software. 

BASIC STUDY 

  1. Folded Dipole 

 

Figure 2-1 λ/2 Folded Dipole 

As Figure 2-1, The Folded Dipole antenna can be made by connecting two parallel dipole antenna 

with a fine lead. Also the antenna folding a conductor as the length isλ/2, and of fine and 

long shape is named a λ/2 folded dipole (or half-wave folded antenna）. 

For aλ/2 folded dipole antenna, when make a conductor spacing S to be narrow in proportion 

to a wave and a thickness of a conductor is same, both conductor size is same and flow a current 

of same phase as Figure 2-2(A). 

Since the sum of current flowing into two conductor is same as a current of a λ/2 dipole 

fed by an same input power as Figure 2-2(C), the field strength and directivity characteristic 

of aλ/2 folded dipole is same as aλ/2 dipole. But an impedance is different with λ/2 dipole. 

That's why the impedance is inverse proportioned to 2multiplication of power feed point current 

in case of an antenna of same input power in P=R*I
2
,R=P/I

2 
. 

 
Figure 2-2  Current Distribution of aλλ/2 folded dipole and dipole 

For the half-wave dipole in Figure 2-2(C), the current is 0 at both end of dipole, and it is 

a sine wave to be maximum value ID at center. Accordingly the current distribution of dipole 

can be indicated as below. 

                  ……(2-1) 
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Here Z is a coordinates axis for the direction of antenna length, and L is a length of antenna. 

In Figure 2-2(A), the half-wave folded dipole has a current distribution of sine wave at dipole 

lead 1. Only, The maximum value on center isn't ID but ID/2. 

This sine wave current become go down 0 at both end of leadl, and become maximum in center of 

a dipole lead2 by increasing again at a dipole lead2. 

Add the distribution of two current flowing into the lead 1 and lead 2 of a folded dipole, it 

is same as a current distribution of a dipole antenna. Accordingly the radial current is also 

same. Also the input impedance of a folded dipole can be taken with below formula. 

       ……(2-2) 
where, PD，ZD，ID is a power impedance of dipole and current and PF，ZF，IF is a impedance of 

a folded dipole and current respectively. 

Consequently, you can see that the input impedance of a fold dipole become larger than a dipole 

input impedance of 73Ω. 

                           ZF= (4)ZD= (4)(73)= 292Ω           ……(2-3) 

When it is same the input power as a thickness of a conductor in Figure2-2（A），(C), as the 

current of.λ/2 folded dipole is half of a 2/2dipole, the input impedance become 73Ωx 2
2
 = 

73 x 2
2
≒300Ω. 

When the thickness is different in Figure 2-2(B), it is characterized that many current flow 

into a lead of thick side. In this time, I2/ I1, the ratio divided before and after is changed 

variously according to the thickness and spacing S of a conductor. 

When the conductor in side of non power feed is thick, become an impedance over 4 times as 

large as aλ/2dipole. It characterize like this that the radial characteristic of a λ/2 folded 

dipole is same as a λ/2 dipole but the impedance value become difference. 

Figure 2－3 shows the impedance change for a  2/2 dipole according to change the diameter 

d2, dl and spacing S of a parallel conductor. As the ratio of d2/d1，and as spacing S is small, 

the ratio of impedance change become large. 

When you want to make this change ration to be large, the 3lines folded dipole consisting 

of 3conductors is used as Figure 2-4. Also in this case, the impedance change ratio is changed 

by the thickness and spacing of each lead complexly, but Figure shows the simple case, and 

when three all are same diameter, the change ratio become 3 
2
= 9. Also can increase the number 

of a parallel conductor. If all conductor is same thick, the change ratio can be calculated 

in N
2 
(Number of Conductor). 

The folded dipole has a impedance change property in compared with 2/2dipole.except this it 

has the merit as below 

i) Driving Frequency Range is taken widely.  

ii) Though the non-balanced class power feed lead as a coaxial cable directly, the 

 matching become easy. etc. 

Therefore it used for the radiator elements of Yagi antenna.Since the radial resistance of 

radiator become lower value than 20Ωin Yagi antenna, if use the folded dipole which the 

impedance change ratio is 4 for a radiator, the input impedance can be 70-80Ω.So it become 

matching to the 300Ω power feed if the impedance change ratio is 30(three line type) with 

the coaxial cable of characteristic impedance 75Ω. 
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2. Impedance Matching 

For the most suitable power transmitting, it must same the power impedance as load impedance. 

Figure 2-5 indicates the simple circuit of power voltage Vs internal resistance Rs and load 

resistance RL. The maximum power transmitting is generated when Rs = RL. 

 

Figure 2-5 Impedance Matching between a power and load  

for the maximum power transmitting 

The same rule is applied for the antenna system. For the maximum power transmitting, the antenna 

input impedance Z.., must same as a transmitting lead or waveguide impedance ZL as Figure 2-6. 

When the transmitting lead and antenna don't match completely, instead of the partial 

transmitting power is radiated .through an antenna, it is returned by reflecting. 

In case of the receiving antenna, the partial power received by antenna isn't transmitted 

to receiver, and re-radiation will be occurred through a receiving antenna. 

When impedance non-matching, Figure 2-4 shows the relational formula between power transmitted 

through impedance nonuniform point and the reflected power. 

 

Figure 2-6 Impedance at a transmitting lead and antenna connecting point 
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        ……（2-4） 

where, PT is the power transmitted through a impedance nonumiform point 

             Pr/l is the power reflected at a impedance nonuniform point 

             SWR is a sine wave ration(SWR= Zant/ZL ). 

If complete matching, since Zant = ZL. SWR= Zant/ZL =1,  the sine wave isn't occurred. 

In this case, the reflected power isn't.  

    …….（2-5） 

Accordingly, all the power is transmitted. 

When power feed into transmitting lead in 4times half-wave folded dipole 73Ωof a lead 

impedance(4x73=292Ω), the sine wave generated. The sine wave ratio in this time become 

 

SWR=Zant/ZL ＝4/1=4                            ……（2-6） 

      ……（2-7） 

In this time 64% of power is transmitted, 36% is reflected. This result isn't the worst state. 

But it isn't advisable also. Accordingly it is desirable that do an impedance matching between 

the transmitting lead and antenna as Figure 2-7. 

 

Figure 2-7 Impedance Matching between the Transmitting lead and Antenna 

 

3. Half-Wave Folded Dipole 

The antenna experiment set contains a 0.5 GHz half-wave folded dipole antenna. As former case, 

The dipole of this type has a 292Ω input impedance. The transmitting lead given to connect 

to 0.5GHz antenna is a 50Ω coaxial cable. It is presented 2ways to connect a 50Ω coaxial 

cable and a 292Ω folded dipole antenna. One is without Balun ,and another is with a balun 

used for 4:1 impedance change. 

3.1 Connecting without a Balun 

Figure 2-8 shows the configuration connecting a 50Ωcoaxial cable, a 300Ω parallel round 

lead and some 300Ωhalf-wave folded antenna without a Balun. 

The relation between the transmitted power PT and the reflected power PRft is  

     ……（2-8） 
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Figure 2-8 Folded Dipole Without Balun 

If the impedance is matched completely, the power of 100% is transmitted. But some 50% is 

transmitted in this time, the remained half will be reflected. The lost 3dB is what has a 

damage of -3dB in compared with a complete impedance. 

 

3.2 Connection using a Balun of 4:1 impedance change 

 

Figure 2-9 Folded Dipole with Balun 

Figure 2-9 shows the connection of a 50Ωcoaxial cable and a 300Ω half-wave folded dipole 

with a Balun of 4:1impedance change. It's better that connect the 72Ωcoaxial cable as RG-59U 

to a parts assembled the folded dipole and balun. But in this case connect with 50Ωcoaxial 

cable, the 4:1 change isn't desirable change. 

When match 50Ω and 300Ω, needed 6:1 impedance change desirably. But despite of the incomplete 

matching, it is sufficient to an improving effect with only 4:1 impedance chage. 

Since the 4:1  impedance converter let the 300Ωimpedance change to 75Ωimpedance ,the 

impedance change with a 50Ωcoaxial cable make a sine wave of 75/50=1.5 to be occurred .In 

this case,The relation between a transmitting power and a reflected power is as below. 

              ……（2-9） 

Accordingly, all the power of 100% isn't transmitted, and it is transmitted 0nly 96% and 

reflected only 4%. 

The power transmitting effect of half-wave folded dipole with balun become better as good 

as 2times than a folded dipole without it. This lead a result of difference as almost 3Db 

when measure. 

 

EXPERIMENT PROCEDURE 

SETTING OF EXPERIMENT APPLIANCE 

  1. Set the transmitting receiving antenna positioner which is a main appliance of experiment 

set and computer. 

  2. Set the height control bar on a transmitter and fix a 500MHz Yagi antenna on antenna fixing 



 29 

pack, and then set an antenna on a polarization control plate. In this time,set an antenna 

to get an even polarization characteristic evenly witl ground. The receiving antenna setting 

as Figure 2-10 has an even polarization characteristic. 

 

Figure 2-10 Setting of Even Polarization Transmitting Antenna 

    On condition that a power OFF of main controller, set the frequency select switch in 

 transmitter in OFF, and connect a 500MHz oscillation output terminal and a Yagi antenna 

 with SMA Cable. 

3. Connect the stationary bar to a receiver and fix the folded dipole antenna used the 4:1 

impedance conversion balun to get an even polarization characteristic at a polarization 

control plate. Place an antenna on rotation center of a receiver using the position control 

plate. See Figure 2-11 to set. 

 

Figure 2-11 Setting of Even Polarization Receiving Antenna 

     Connect the folded dipole antenna used for receiving and the RF IN terminal in receiver 

 with a SMA Cable used for lm, and connect the OUT PUT(1KHz) terminal in receiver and the 

 INPUT(1KHz) terminal in a main controller with a BNC Cable. 

 

4. Calculate a folded dipole in 500MHz using below formula, and measure an actual length of 

 antenna. Then record in Table 2-1.  

The exact oscillation frequency of a RF signal generator is 500MHz.  
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Table 2-1 The Length of Folded Dipole Antenna[era] 

 Theoretical Length of Antenna Actual Length of Antenna 

λ   

λ/2   

L   

d   

t   

 

5. Make the spacing between antennas to be isolated as r=l.5m as Figure 2-12, and set to be 

parallel the center part of Yagi antenna and folded dipole antenna. 

 

Figure 2-12 Distance between Antennas r 

6. On condition that the power OFF of main controller, execute an antenn software after setting 

as below. 

    - Power OFF 

    - 500MHz Oscillation Switch off 

    - 2 GHz Oscillation Switch off 

    - 10 GHz Oscillation Switch off 

    - Modulation Switch (Mod) off 

 

7. Turn on the main controller power and set the oscillation switch and modulatiox switch 

as below. 

     - Power ON 

     - 500MHz Oscillation Switch on 

     - 2 GHz Oscillation Switch off 

     - 10 GHz Oscillation Switch off 

     - Modulation Switch (Mod) on 

 

8. Execute a AT3200 Antenna Experiment system program and select the antenna type, then select 

E-Plane as Plane, and control to be displayed 0 on the antenna gain displayer by controlling 

the signal attenuation. If the control is completed, start data acquisition. 

9. The data acquisition is completed, save got radial pattern into file. Use a data box to 
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 see a radial pattern exactly. Set MSP(Maximum Signal Position) on 0°, can see a radial 

 pattern of this antenna. 

 

10. For the 500MHz Yagi antenna used for receiving get an even polarization characteristic, 

 set the polarization control plate to the right angle position with ground by rotating 

 90°as Figure 2-13. 

 
Figure 2-13 Setting of Even Polarization Transmitting Antennana 

11. For the folded dipole antenna used for receiving, set by losing the position control  

screw and making a polarization control plate to rotate 90°and then setting it fitting 

the center of antenna in center of a rotational axis of receiver. And make the center  

of Yagi antenna used for transmitting and center of folded   dipole antenna used for 

receiving to parallel each other. 

 

Figure 2-14 Setting of Vertical Polarization Receiving Antenna 

12. Keep the drawn pattern in state of E-Plan, and after click Initialize in edit menu of 

 software, select H-Plane as Plane and then click a Auto button for data acquisition. The 

data acquisition is completed, save two drawn pattern file. 

 

13. Keep the 500MHz Yagi antenna used for transmitting to get a vertical polarization 
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 characteristic, and make the folded dipole antenna used for receiving to get an even 

polarization characteristic. In this time, set the Yagi antenna taken a vertical 

polarization characteristic and the folded dipole antenna taken an even polarization 

characteristic in parallel fitting its center by referring Figure 2-15. 

 

14. After click Antenna Initialize in Edit Menu of software, click Screen Delete in Edit 

 Menu of a software then click the Auto button for a data acquisition. 

 

15. Observe three radial pattern. Especially take note of the third experimental result. 

 

16. Set again for each receiving-transmitting antennas get an even polarization 

 characteristic. The distance between antennas is r=l.5m. Set the environmental condition 

 to same as the first experiment. Take E-Plane radial pattern of a folded dipole antenna 

 and save in Dummy-Plane. 

 
Figure 2-15 Even and Vertical Antenna 

Theoretically this radial pattern must same as the first pattern except an effect caused 

by a power damage. If the pattern differ so much, must do properly by finding the position 

where a reflection can be occurred. After do suitably, experiment continuously and save 

a new pattern in E-plane. Click Data Indication Line in upper Edit Menu of a data analysis 

program. On the screen, 2 cursors used for E-Plane(Blue, White) and 2 cursors used for 

H-Plane (Yellow, Green) is appeared. Click the cursor by both side of color displayer, 

the values on a displayer will be changed with the cursor of same color moving. These 

indicate a position angle of cursor and a receiving power in that time by dB, and the angle 

between cursors and difference of power is displayed on 2 displayer. Record the taken values 

in Table 2-2. 

Table 2-2 Receiving Power for Angle 

Angle 

 
0° 30

°
 60° 90° 120° 150° 180° 210° 240° 270° 300° 330° 

Receiving 

Power of 

E-Plane 

For Angle 

            

Receiving 

Power of 

H-Plane 

For Angle 

            

 

17. Take an angle which the maximum power is received in E-Plane pattern and a receiving 

power in that time using the a cursor. Click the Maximum Single Level button on a E-Plane 

data window and confirm if the measured value is same as a taken value by using the cursor, 
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then record in below Table 2-3. 

Table 2-3 Comparison of E-Plane and Theoretic Value 

Receiving Power  Taken Value 

With cursor Angle  

Receiving Power  Value by Maximum  

Single Level Icom Angle  

                                                                                                                                                                                          

18. Take a half angle of a main beam size in the E-Plane pattern by using two cursors. Click 

 the Half Power Beam Width button on the E-Plane data windo and confirm if a measured 

 value and the taken value by using a cursor is accord. Calculate a half power beam width 

 of a folded dipole antenna in E-Plane by using below formula. 

 

19. Repeat the 18th experiment procedure in a radial pattern of H-Plane. 

HPBWE=                  

20. Delete all cursors by clicking a data indication line in Edit Menu. Compare the 

 experimental value with the  values taken from antenna software. If the calculated 

 result differ from these values, repeat an experiment and calculation (when difference 

 over Τ). 

 

21. Save the data of E-Plane and H-Plane, and output this result.  

 

22. Until now experimented with a folded dipole antenna using the impedance conversion balun 

of 4:1. To find a difference of an antenna with 4:1 impedance conversion balun and without 

it, experiment based on the experiment procedure from No.1 through No. 21. And compare 

the data in this time(without 4:1     impedance conversion balun) with the data with 

it and record. 
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EXCERCISE 

1. Explain why there is a difference between the impedance of a folded dipole and aλ/2 dipole. 

                                                                                

                                                                                

2. Explain some difference between when to be impedance matching and when to be impedance 

 matching. 

                                                                                    

                                                                                                      

3. Explain how change of a gain, directivity and antenna efficient etc when feed directly 

to a folded dipole with 75Ωcoaxial cable and when feed with 4:1 balun. 

                                                                               

                                                                               

4. Explain the impedance change caused by the distance d of a folded dipole antenna. 

                                                                               

                                                                               

5. What's the polarization characteristic of a folded dipole antenna. 
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EXPERIMENT 3-3 λ/4 GROUND ANTENNA 

 
Let's experiment a radial pattern of E-Plane and H-Plane for theλ/4 folded antenna used for 

500MHz in this experiment. Let's see a polarization characteristic, of a λ/4 folded antenna. 

Calculate a half power beam width of a;λ/4 folded antenna 

BASIC STUDY 

After an existence of a electric wave is proved by Herz in 1888, in 1901 Marcon succeeded the 

crossing telecommunication of Atlantic by finding the antenna, so the electric wave was to 

be used in telecommunication. It is a ground antenna that used in that time so it is used to 

call Marconi Antenna. The ground antenna is a representative initial antenna, and it is used 

majority for a long wave an medium wave antenna. 

 

1. Ground 
The ground antenna is an antenna contacted a output terminal in transmitter out one axis of 

power feed lead to the earth. The power feed for this antenna is fee between earth and antenna 

conductor as Figure 3-1. 

 

Figure 3-1 Representative Ground Antenna 

In case of aλ/2 dipole antenna in different from a ground antenna, connect the both end of 

a high frequency source. Generally in case of a folded antenna, the length of a conductor 

may shorter a λ/2 than non ground antenna, it has a merit that it is easy to match if a power 

feed point is low. But since a returning road of antenna current pass earth, it has demerits 

that the antenna efficient go down as a damage is large caused by ground resistance if a ground 

is insufficient. 

 

2. VERTICAL GROUND ANTENNA 

Let's think the case of the conductor length is λ/4(four-first frequency). Suppose that the 

earth is complete conductor flat, it is equivalent toλ/2 dipole in free space because can 

consider a image antenna of lengthλ/4 as Figure 3-2. 
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Figure 3-2 Power Distribution and Directivity of λ/4 Vertical Ground Antenna 

Accordingly the field strength of earth is half of λ/2 dipole radial field strength flowing 

the same size current into center(current anti-node) of lead. Also power feed point impedance 

becomes half of a center feed λ/2 dipole, and the resistance becomes about 36Ω. 

Since the cubic directivity take on earth only, in the,λ/4 vertical antenna, it becomes shape 

like what cut a doughnuts circularly to half and lay face down the section as Figure 3-2. 

Figure 3-3 indicates a directivity of vertical side and a field strength on earth when change 

length of a conductor. The strength of field in Figure is a value within a radial power of 

lkm and distance of lmile(about 1.6km). When the length of conductor is 5λ/8= 0.625λ, the 

field strength on earth becomes maximum, and indicate about 1.4times of the distance is 0.25

λ. 

 

Figure 3-3 Length (Height) of Vertical Antenna and Vertical Side Pattern 

Since a gain of a folded antenna standardize a vertical λ/4 antenna, it become, I about 

2times(3dB) of a 5λ/8 vertical antenna. If longer than 5λ/8, the sub lobe of an obtuse angle 

becomes large and the field strength go down. 

The power feed impedance of a vertical ground antenna becomes half of a dipole antenna, it 

becomes different for the thickness of conductor as well as nor ground antenna. 

Figure 3-4 indicates the impedance change for a length and thickness of conductor. 

 
Figure 3-4 Power Feed Point Impedance of Vertical Ground Antenna 

 

3. λ/4 Ground Antenna 
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Theλ/4 ground antenna is equivalent to aλ/2 vertical dipole antenna by earth, complete 

conductor.Figure 3-5 shows ideal pattern of an even and a vertical directivity of this antenna. 

The vertical directivity is about below 45", very low. Also even directivity is non directivity, 

as if radiate the electric wave equivalently to all directions. 

Since the power feed point impedance of this antenna is 36Ω, can use a coaxial cable of 50

Ω as a power feed lead, but put a gamma, match or element one more in parallel to use for 

good matching. 

Take the element length of antenna from below formula. 

 

But this is theoretical, in actual antenna, by considering an uniaxial ratio, take with below. 

 

Figure 3-5 shows the case that a λ/4 ground antenna is on the face of a complete conductor. 

This is a half length of a λ/2 or half wave dipole. 

 

Figure 3-5 λ/4 Ground Antenna on Complete Ground Antenna  

 In monopole antenna(λ/4 ground antenna), it is like that the current flow into a pole of one 

 side. Also the input voltage is half of a dipole. Accordingly the input impedance of a monopole 

becomes half of the input impedance of a dipole. 

         ……（3-1） 

Since the current is same asλ/2dipole, the radial power may be same. But the beam  width  

becomes half of dipole because there are the ground face. Accordingly the directivity and gain 

become 2times of a dipole. 

      ……（3-2） 

The radial pattern of a/l/4 monopole on the ground face is same type as the radial pattern 

of a λ/2 dipole over (zero) angle. 

The theoretical radial pattern is given in Formula 3-3, and it is same shape as a half wave 

dipole. 

   ……（3-3） 

If the monopole put on the ground face as the height d/2 as Figure 3-6, the monopole antenna 

drive as if two antennas is arranged. The electric waves radiated from upper part and lower 

part antennas becomes different with each height on the ground face. 
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Figure 3-6 Radial Coupling by Monopole and Image Monopole 

This is to generate an Array factor. 

Figure 3-6 shows the coupling shape of the electron wave radiated from monopole and image 

monopole, this is similar what couple the radial electri wave by a dipole on a complete 

conductor. 

 

λ/4 Ground Antenna 

Figure 3-7 shows the λ/4 ground antenna. This antenna is fed power through hall of a large 

ground from 50Ωcoaxial cable. The size of ground face is important for the design of ground 

antenna. The idea ground face is unlimited size. Actually the ground face of radius 5λis almost 

ideal ground, it must have a minimum radius 0.5λ. The ground antenna designs in the set for 

antenna experiment has a ground face of size 0.5λ. Also the coaxial cable feeding to antenna 

has 50Ω impedance. Accordingly take a coupling by making the impedance of λ/4 ground antenna 

to change to 36Ω. 

The characteristic impedance of a coaxial cable is a function between a ‘a’radius of central 

conductor and 'b', distance till central conductor and ground conductor. The relation is given 

as Formula 3-4. 

          …….（3-4） 

When a=0.1595cm, b=0.317cm, the characteristic impedance becomes 41.5Ω,this is a geometric 

average value of 509, characteristic impedance of coaxial cable and 36Ω, input impedance of 

λ/4 ground antenna. 

 

Figure 3-7 Coaxial Power Feed λ/4 Ground Antenna and Ground Face 

 



 39 

EXPERIMENT PROCEDURE 
1. set a main controller, transmitting and receiving antenna positioner and computer which 

are main instrument of an experiment set for antenna. 

2. Set the height controller on a transmitter and fix an 500MHz Yagi antenna console fixing 

pack of an antenna, then fix an antenna on follow control plate. In this time set an antenna 

in parallel with earth to get an even polarizaticed characteristic. The transmitting antenna 

   set as Figure 3-8 has an eve polarization characteristic. 

 

Figure 3-8 Setting of Even Polarization Antenna 

   Set the frequency selecting switch to OFF, and connect the 500MHz oscillated output 

terminal and Yagi antenna with a SMA cable. 

3. Fix the λ/4 ground antenna to get an even polarization characteristic on the polarization 

control plate of receiver. Set an antenna in center of rotating axis console receiver by 

using the moving control plate of receiver. Set by refering Figure3-9. 

 

Connect the λ/4 ground antenna and the RF IN terminal of receiver with a SMA Cable used 

for lm, and also connect the OUT PUT(1KHz) of receiver and the input(1KHz) terminal of main 

receiver with a BNC Cable used for lm. 

 

Figure 3-9 Setting of Even Polarization Receiving Antenna 

4. Calculate the length ofλ/4 ground by using below formula, and measure the length of an actual 

antenna, then record in Table 3-1. 
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Table 3-1 Length of λ/4 Ground Antenna [cm] 

 Theoretical Antenna Length Actual Antenna Length 

λ   

λ/2   

L   

R   

t   

5. Make the distance between antenna as r=l.5m to isolated, adjust the center of a transmitting 

antenna and receiving antenna in parallel. See Figure 3-10 to set. 

 

Figure 3-10 Distance between Antennas 

6. Set in condition of the power of main controller as below. 

-Power OFF                                                          ~ 

- 500MHz osciUation switch off 

-2 GHz oscillation switch off                                              

-10 GHz oscillation switch off                                              

-Modulation switch (Mod) off                                                                                                                                   

 

7. Turn on the power of main controller,and set the oscillation switch and modulation switch 

as below,then execute the Antenna Trainer program. 

- Power ON 

- 500MHz oscillation switch on 

- 2 GHz oscillation switch off 

- 10 GHz oscillation switch off 

- Modulation switch (Mod) on 

 

8. Open the window of data acquisition in Antenna Trainer program and select an antenna. And 

select E-Plane as Plane and adjust to be displayed 0 on gain displayer by adjusting the 

quantity of signal attenuation. This adjust is completed, start the data acquisition. 

 

9. The data acquisition is completed, save get radial pattern in file. To confirm the radial 

pattern exactly, use the data box. Set the MSP(Max. Signal Position) to 0°, can see exact 

radial pattern. 
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10. Set the 500MHz Yagi antenna used for receiving to get an vertical polarization characteristic 

 in parallel with earth by rotating the polarization control plate as 90°as 3-11. 

 

Figure 3-11 Setting of Vertical Polarization Transmitting Antenna 

 

11. Set theλ/4 ground antenna used for receiving in vertical with earth to get a vertical 

 polarization characteristic as Figure 3-12, and set in center of rotating axis by moving 

 the position control plate. 

And in this time set the center of receiving antenna and the ground plate of a monopole 

antenna in a straight line. 

 

Figure 3-12 Setting of Vertical Polarization Receiving Antenna 

12. Keep the pattern drawn in E-Plan and click the Antenna Initialize in Edit Menu of a software, 

and click the auto button to data acquisition. Data acquisition is completed save two drawn 

pattern in file. 

 

13.Keep the 500MHz Yagi antenna used for transmitting to get a vertical polarization 

 characteristic and set the ;t/4 ground antenna used for receiving get an even polarization 

 characteristic. 
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Figure 3-13 Even and Vertical Antenna 

 

14. After click Antenna Initialize in Edit Menu of a software, click Screen Delet and click 

  the auto button for a data acquisition. 

 

15. Observe three radial pattern. 

 

16. Set again each transmitting-receiving antennas to get an even polarization: 

characteristic. The distance between antennas is r=l.5m. Make the surrounding condition 

to same as the first experiment. Take a E-Plane radial pattern of aλ/4 ground antenna and 

save in Dummy-Plane.  

Theoretically, except an effect by power damage, this radial pattern must same as the first 

radial pattern. If the pattern is different so much, have to do properly by finding the 

point where a reflection can be occurred. After do properly, continue the experiment and 

save the new pattern in E-Plane. 

 

Click the data indicating line on upper View Menu of a data analysis program . 

Two cursor (Blue, White) used for E-Plane, and two cursor (Yellow, Green) used for H-Plane 

are appeared on the screen. Click the arrow mark on botl side of color displayer, the value 

in displayer will be changed by moving the cursor of same color. This shows the position 

angle of cursor and the receiving power in this time by dB, and shows the angle between 

cursors and the difference of power in below displayer. Record the taken value in below 

3-2. 

Table 3-2 Receiving Power for Angle 

Angle 

 
0° 

30

° 
60° 90° 120° 150° 180° 210° 240° 270° 300° 330° 

Receiving 

Power of 

E-Plane 

For Angle 

            

Receiving 

Power of 

H-Plane 

For Angle 

            

 

17. Take the angle received a maximum power in E-Plane pattern and receiving power in that time 

by using a cursor. Confirm if the measured value by pressing the Maximum Single Level button 

on E-Plane data window and the value taken by using cursor are accorded, and record in below 

table3-3. 
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Table 3-3 Comparison of E-Plane and Theoretic Value 

Receiving Power  Taken Value 

by using a cursor Angle  

Receiving Power  Value by Maximum  

Single Level Icom Angle  

 

18. Take a half angle of a power size of main beam in E-Plane pattern by using two cursors. 

Confirm if the measured value by. pressing the Half Power Beam width button on E-Plane data 

window and the value taken by using cursor are accorded. 

 

Calculate the half power beam width in E-Plane of k/4 ground antenna by using below formula. 

 

 

19. Repeat No. 18 in this experiment procedure with the radial pattern of H-Plane. 

HPBWE=                             

         

20. Delete all the cursors by clicking the data indicating line on View Menu Compare the 

 experimental values with the given value in antenna, software. If calculated result is not 

 accorded with this values, experiment and calculate again. 

 

21. Save the data of E-Plane and H-Plane, and output the result. 
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EXCERCISE 
 

1. Why does the length of ground antenna becomes half of a dipole ? 

                                                                       

                                                                       

 

2. How over large size is  the ground face of a ground antenna ? 

                                                                       

                                                                       

 

3. What/s the input impedance of a ,λ/4 ground antenna? 

                                                                       

                                                                       

 

4. Describe the radial pattern of a λ/4 ground antenna. 

                                                                       

                                                                       

 

5. What's the polarization characteristic of a λ/4 ground antenna ? 
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EXPERIMENT 3-4 DROOPING ANTENNA 

 

In this experiment let's the radial pattern of E-Plane and H-Plane for a drooping antenna used 

for 500MHz. We will study the polarization characteristic of a drooping antenna. Let's calculate 

the half-power beam width of a drooping antenna by using an antenna software. 

 

BASIC STUDY 

  1. Drooping Antenna 

  There is an element of /1/4 length vertically from a central lead of a coaxial cable as Figure 

4-1. Also, as this is the antenna attached a ground lead of ,λ/4 length radially in sheath 

conductor, the lead has an optional angle with earth, this is the antenna attached the counter 

poise ground lead of a kind instead of a ground of λ/4 ground antenna. 

 
Figure 4-1 Ground - Plane          Figure 4-2 Vertical Element La 

For there is this counter poise ground lead, this is prevented a current from leaking from 

a sheath conductor of a coaxial cable to external, and there is no unnecessary radiation of 

an electric wave in cable. Assemble vectorially the radial current placed in optional angle 

for earth, since the radial length isλ/4, a radial field is decided by the current flowing 

into vertical element and the sum of a vector of a radial current. 

 

This antenna has a similar characteristic to λ/2 dipole antenna, but the radiation of an 

electric wave can't be occurred almost to the direction of earth, and the radiation is occurred 

in the area bounded by the central lead and ground lead. Accordingly this is used mainly in 

a simultaneous call with the airplane taken off and landed in the control tower of airport. 

The length of a central element is taken by follow formula(Figure 4-2). 

 
Also the length of radial is taken by follow formula since make the length of radial to be 

longer as 2-3% than a vertical element for the radial of an electric wave becomes maximum 

in vertical direction. 
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Since the impedance at the power feed point of this drooping antenna is very low as 21-24

Ω, if feed' directly with 50-75Ω of a coaxial cable, SWR is to be worse. So to go up the 

impedance at the power feed point of this antenna, following method has been used. 

Figure.4-3 shows the folding shape of a vertical element. Since the impedance at the power 

feed point becomes 4times of it before fold, can go up to 84-96Ω. 

 

 Figure 4-3 Fold the Vertical Element 

In figure 4-4, as incline the counter poise ground element to below, the impedance at a power 

feed point becomes higher. Figure 4-5 indicates tile angle of a ground element and the value 

of an impedance, this becomes about 21Ω when becomes 90°and 50Ω in about ,30~38°and becomes 

70Ω when go down just below 0 °. 

Figure 4-6 shows the setting of gamma matching system in a power feed part, Make the impedance 

at a power feed point to match to the characteristic impedance of a coaxial cable by controlling 

the length of a gamma, load place parallel with a vertical element, and the variable condenser 

between the load and the central conductors of a coaxial cable. 

Figure 4-7 shows the antenna taken a matching by placing a vertical radial in a coaxial antenna. 

As connect a parallel radial, d, a distance between a central lead of a coaxial cable and a 

vertical element, is taken by below formula. 

 

ZA: Impedance at a power feed point of drooping antenna 

Zo: Characteristic Impedance of Coaxial Cable 

 

Figure 4-4 Vertical and Impedance      Figure 4-5 Angleθand Impedance  

of Vertical Element 
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Figure 4-6 Gamma Match        Figure4-7 Place the Vertical Radial in a Coax 

 

The experiment set of an antenna contain a drooping monopole antenna in addition to a standard 

monopole. The drooping monopole is very easy design method of monopole. Figure 4-8 shows a 

drooping monopole exemplarily. 

 
Figure 4-8 Drooping Monopole 

To explain the characteristic of a drooping antenna, consider a half-wave dipolehaving impedance 

of 73Ω as Figure 4-9. If each leads consisting the half of below part is divided to 180°

as Figure 4-9(c), it becomes a λ/4 ground antenna taking the characteristic impedance of 37

Ω. But as Figure 4-9(b), if consist of each leads stretching for 90°(45°from a right angle), 

it becomes a drooping antenna getting a characteristic impedance of almost 50Ω. This is matched 

exactly up to the characteristic impedance of a coaxial cable. 

 

Figure 4-9 (A) ltalf Wave Dipole (B) Drooping Antenna (C) A/4 Ground Antenna 

 

 



 48 

EXPERIMENT PROCEDURE 

SETTING OF EXPERIMENTAL INSTRUMENT 

1. Set a transmitting.receiving antenna positioner and a computer which are main instrument 

of an antenna 

experimental set. 

2. Set a height controller on a transmitter and fix the 500MHz Yagi antenna on a fixing pack 

of an antenna, then 

set on the polarization control plate. Set this at a parallel position with earth for the 

antenna get a parallel 

polarization characteristic. The transmitting antenna set as. Figure 4-10 has a parallel 

polarization 

characteristic. 

 

Figure 4-10 Setting of a Parallel Polarization Transmitting Antenna 

  Set OFF the selection switch and modulation switch in a transmitting of main controller, 

connect a 500MHz 

oscillation output terminal and Yagi antenna with SMA used for 2m. 

3. Attach the stationary bar on a receiver. And fix the drooping antenna on a polarization control 

plate of upper stationary bar to be got a parallel polarization characteristic. Set it in 

center of a rotational axis of a receiver by loosing the position control screw of a receiver 

and moving the control plate. See Figure 4-11 to set. 
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Figure 4-11 Setting of Parallel Polarization Receiving Antenna 

  Connect a coupling terminer of a drooping antenna and a RF IN terminal of a receiver with 

a SMA cable used 

for lm, and connect a OUT PUT(1KHz) terminal of a receiver and a Input(1KHz) terminal of a 

main controller 

with a BNC cable used for lm. 

 

4. Calculate the length of a drooping antenna and measure the actual length of an antenna in 

500MHz by using 

below formula, and record in Table 4-1. 

 
Figure 4-12 Drooping Antenna 

 

Table 4-1 Length of Drooping Antenna [cm] 

 Theoretical Antenna Length Actual Antenna Length 

λ   

L   

D   

t   

 

5, As Figure 4-13, the distance between antennas is isolated as r=l.5m. Make the center of each 

transmitting ~ receiving antenna to be in a straight line at a same height. 
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Figure 4-13 Distance between Antennas r 

6. Set in condition of the power of a main controller as below. 

    - Power OFF 

    - 500MHz Oscillation Switch off 

    - 2 GHz Oscillation Switch off 

    - 10 GHz Oscillation Switch off 

    - Modulation Switch (Mod) off 

7. After set a switch in main controller as below, execute the Antenna Trainer Program. 

    - Power ON 

    - 500MHz Oscillation Switch on 

    - 2 GHz Oscillation Switch off 

    - l0 GHz Oscillation Switch off 

- Modulation Switch (Mod) on 

8. The program window is executed, make the data acquisition in Pop Up Menu to be executed.Here 

after select Antenna, select E-Plane as Plane, and control the signal attenuation to be 

displayed 0 in a displayer for an antenna gain. The control is completed, start the data 

acquisition. 

9. Data acquisition is finished, save the taken radial pattern in file. To confirm the radial 

pattern exactly, use a data box. Set MAP(Max. Signal Position) to 0°,can see a radial pattern 

of this antenna exactly. 

10. For the 500MHz Yagi antenna used for transmitting get a vertical polarization characteristic, 

loose a fixing screw on a polarization control plate and make the control plate to rotate 

as  90°. 

 
Figure 4-14 Setting of a Vertical Polarization Transmitting Antenna 

11. For the drooping antenna used for receiving get a vertical polarization characteristic,set 

as Figure 4-15. 
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Figure 4-15 Setting of a Vertical Polarization Receiving Antenna 

12. After click Antenna Initialize of Edit Menu of a software, acquire a data by clicking the 

Auto button. The data acquisition is completed, save the pattern in file after select H-Plane 

as Plane. 

13.Keep a 500MHz Yagi antenna used for transmitting to get a vertical polarization  

characteristic, and set a drooping antenna to get an even polarization characteristic. In 

this time, for the center of a transmitting antenna taken a vertical polarization 

characteristic and a receiving antenna get an even polarization characteristic is to be in 

strait line, see Figure 4-16 to set.  

 
Figure 4-16 Vertical and Even Antenna 

14. Click Antenna Initialize in Edit Menu of a software, and click Delete Screen in Edit Menu 

again, then acquire a data by clicking the Auto button. 

15. Observe three radial pattern. 

16. Set again each transmitting-receiving antenna to get a vertical polarization characteristic. 

The distance between antennas is r=l.5m. Make a surrounding condition to same as the first 

experiment. Take a E-Plane radial pattern of a drooping antenna and save in Dummy-Plane. 

     

Theoretically except an effect caused by a power damage, this radial pattern must same as 

the first pattern. If the pattern is differ very much, have to do suitably by  finding a 

point where a reflection can be occurred. After do suitably, continue the experiment and 

save a new pattern in E-plane. 

Click the data indicating line in the Edit Menu of upper menu of a data analysis  program. 

Two cursors(Blue, White) used for E-Plane and two cursors(Yellow, Green) used for H-Plane 

are appeared. Click the arrow mark at both side of a color displayer, the value in a displayer 

by moving the cursor of same color. These display the position angle of cursor and the 

receiving power as dB, The difference of an angle between cursors from a power on below two 

displayer. Record the values in below Table 4-2. 
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Table 4-2 Receiving Power for Angle 

Angle 

 
0° 30

°
 60° 90° 120° 150° 180° 210° 240° 270° 300° 330° 

Receiving 

Power of 

E-Plane 

For Angle 

            

Receiving 

Power of 

H-Plane 

For Angle 

            

 

17. Take a receiving angle of max. power in E-Plane pattern and the receiving power in that 

time by using a. cursor. Confirm if the measured value and the theoretic value are accorded 

by clicking the Maximum Single Level of E-Plane data window. Confirm if the taken value 

by using a cursor and record in below Table 4-3. 

 Table 4-3  Comparison of E-Plane with Theoretic Value 

Receiving Power  Taken Value 

by using a cursor Angle  

Receiving Power  Value by Maximum  

Single Level Icom Angle  

 

18. Take half angel of a main beam power in E-Plane pattern by using two cursors. Click the 

Half Power Beamwidth button.  

 

Calculate a half power beam width of a drooping antenna in E-Plane by using below formula. 

 

19. Repeat the experiment of no. 18 in radial pattern of H-Plane. 

 

20. Delete all cursors by clicking a data indicating line in Eduit Menu. Compare the experimental 

values with a given values  in  an antenna software. If the calculated result isn't accord 

with these values, experiment and calculate again. 

 

21. Save the data of E-Plane and H-Plane, and output the result. 

 

22. Experiment from above no. 3 to no. 21 with taking the place of a ground plate(Large, Small)  

based on the experiment procedure. And compare this experimental result with above result, 

record. 
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EXCERClSE 

1. Where is the using place mainly for a drooping antenna, Why so ? 

                                                                         

                                                                         

2. What is the role of four lead placed in each corner of a drooping antenna? 

                                                                         

                                                                         

3. What's the shape of a radial pattern for a drooping antenna ? 

                                                                         

                                                                         

4. The impedance and radial pattern according to a gradient angle of four lead 

   placed on each corner of a drooping antenna. Take an impedance and radial 

   pattern in case of the gradient angle of four lead is 30°,45°,60°,90°. 

                                                                         

                                                                         

5. What is the radial characteristic with a drooping antenna ? 
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EXPERIMENT3-5 FULL-WAVE LOOP ANTENNA 

In this experiment,let's measure a radial pattern for a E-Plane and H-Plane of a full-wave loop 

antenna. We will study a polarization characteristic of a full-wave loop antenna. Let's calculate 

a half-power beam width of a full-wave loop antenna by using an antenna software. 

 

BASIC STUDY 

1. Infinitesimal Loop Antenna 

The infinitesimal loop antenna which is smaller size than 8/,t or 8/,1 has dual relation 

to a infinitesimal dipole antenna, it is used for a special application such as direction 

searching. 

Here the duality theory is a theory settling the substitutional relation formed between 

a radial by power resources(infinitesimal dipole) and a radial by magnetic current 

resources(infinitesimal loop). 

  

Figure 5-1 Current in Infinitesimal Loop Antenna 

Since a loop length of an infinitesimal loop antenna is very shorter than wave, in all 

part, can regard the current as an amplitude and phase, etc as Figure 5-1. 

Accordingly the field to direction of Z axis becomes "0"(zero). 

For all direction except Z axis, the radial pattern not to be "0" alike an infinitesimal 

antenna. This infinitesimal loop antenna can be substituted for an infinitesimal antenna 

placed in zero point along z axis without change of a radial pattern. But the input 

resistance of an infinitesimal loop antenna is very little value as below 122. Accordingly 

use it as a receiving antenna but it is difficulty to use for a transmitting antenna because 

of the radial resistance is too little. 

 

2. Full-Wave Loop Antenna 

1.The loop antenna(full-wave loop antenna) of wave(λ) is used efficiently for has a proper 

gain, and input impedance is a value treating easy(about 100Ω). 

There are various type of a loop antenna. That is a round shape, square, rectangle and 

diamond. These all have a similar radial pattern and gain. 

For the radial pattern of a full-wave loop antenna, it is important to suppose the current 

ranging along the loop line, and to understand  how get the electromagnetic field generated 

along it is added and offset. 

  

2.1 Current Distribution of Full-Wave Loop Antenna 
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Let's think the circle loop antenna of 1 zl of length on X-Y plane. The power feed point 

can be placed anywhere. But the direction of power feed has an important effect on a radial 

pattern. 

 

Figure 5-2 Current Distribution of Loop Antenna of Length 1λ 

Let us suppose that the power feed point is on the bottom of Y axis, and the loop spread 

along X axis without fold by being divided as same length as Figure 5-2. In this figure, 

it can be seen to have a current distribution like a cosine wave has a max. value at power 

feed.Figure 5-3 shows the distribution of a circle loop antenna and how get the 

electromagnetic field generated along this is added and offset, The electromagnetic field 

radiated in this case get add in direction of +Y,-Y and +Z, -Z, but get offset in direction 

of +X,-X. 

  

Figure 5-3 Current Distribution of Circle Loop Antenna 

2.2 Radial Pattern of Full-Wave Loop Antenna 

There are 3 important plane in a loop antenna. That is E-Plane, H-Plane and Loop Plane 

Contained in antenna. To explain this plane, let us consider a square loop antenna. 

 
Figure 5-4 Square Loop Antenna 
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The loop antenna is placed to be parallel in front of you on X-Y Plane, and Z axis is placed 

toward you as Figure 5-4. Compare a loop with a central feed dipole, X-Z plane is E-plane, 

Y-Z plane is H-plane and Loop plane is X-Y plane. 

 
Figure 5-5 (A) E-Plane Radial Pattern     (B) To Measure a E-Plane 

                    of Full-Wave Loop Antenna           Radial Pattern, must Rotate 

The theoretical radial pattern in E- Plane(X-Z Plane) is as Figure 5-5(A). To measure this 

radial pattern, the loop must be rotated toward Y axis as Figure5-5(B). 

 
Figure 5-6(A) H-Plane Radial Pattern       (B) Rotation to measure 

                  of Full-Wave Loop Antenna           H-Plane Radial Pattern 

To measure a radial pattern of H-Plane(x-y plane) indicated in Figure 5-6(A),a loop must 

be revolved on x axis as Figure 5-6(B). 

 
       Figure 5-7 (A) Loop Plane Radial Pattern   (B) Rotation to Measure a Loop 

                 of Full-Wave Radial Pattern          Plane Radial Pattern 
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Finally, to measure a radial pattern of loop plane(x-y plane) indicated in Figure 5-7(A), 

the loop must rotated on z axis as Figure 5-7(B). Let us consider more exactly the 

theoretical radial pattern of E-Plane, H-Plane and Loop Plane expressed in each Figure 

5-5(A), 5-6(A) and 5-7(A).The radial pattern is similar the E- Plane and Loop Plane, but 

the amplitude of a radial。 

As Figure 5-6, the electromagnetic field in center of loop is appeared very strongly as 

to be a composition of electromagnetics occurred by phase current.But on  Y  axis outside 

of a loop, the electromagnetic field becomes more stronger but there is a little phase 

difference. The electromagnetic field of a loop plane becomes smaller than E-plane 

electromagnetic field. 

 

2.3 Polarization 

 

Figure 5-8 Polarization of E-Plane in x Direction 

Figure 5-8(A), (B) shows the current flowing into a loop antenna in different moment each 

other. In figure, to the direction of x axis, to be added the current flowing into loop 

of both half. On the other hand, to Y axis, to be offset a current. Accordingly E wave 

becomes polarized toward X axis. With same principle, in case of a vertical feed which 

a loop has a feed point in the upper side or lower, E wave becomes polarized in parallel. 

In case of a even feed which a loop has feed point in left or right, E wave becomes polarized 

in even. 

 

2.4 Impedance, Gain, Beam width 

When.a size of loop is 1λ, the input resistane of loop antenna becomes a value about 100 

Ω. In this input resistance, the input reactance goes down to very small value. Under 

this condition, the loop antenna is used very efficiently, to be get a proper beam width. 

In this time this loop antenna has a gain about 3.09dB. This is less than 3.82dB, gain 

of a full-wave dipole but larger than 2.15dB, gain of a half-wave dipole. 

Resultingly, theoretically the beam width of this loop antenna is between 47°of a full-wave 

loop antenna and 78~ of a half-wave dipole. 

It can't say that the circle loop is a cube, but almost same as square. If feed the antenna 

at one position, since the sine wave is generated to be a current anti-node at opposite 

point to feed point, and to be a node at a central points, becomes max. radiation toward 

front and rear, vertical with earth. 
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(A) λ/4Spacing Step Dipole (B) λ/8 Fold and Bend of Both Side (C) 1 Wave Loop 

            Figure 5-9 Method Thinking the l wave Loop Antenna 

Accordingly it can seems that the square loop antenna in (A) is what isolate both side 

of the two folded and bendedλ/2 doublet as each λ/8 to get by spacingλ/4. The same, 

it can seems that the loop of diamond shape in (B) is what isolate the antenna of inverted 

V shape. 

 

Figure 5-10 Input Impedance of l Wave Circle Loop 

The gain of a full wave loop antenna is different according to thickness of element, but 

a square loop is about ldB, and a circle loop is some 1.2-2dB. Figure 5-10 shows the change 

of input impedance around resonance frequency of a circle loop. When an antenna is tuned, 

the input impedance of a loop using a thin lead is about 140Ω. Also the tuning frequency 

is related to the thickness of an element like λ/2 dipole, but becomes frequency that 

the entire length becomes a little longer than 1wave. Also since this loop antenna has 

a larger range of using frequency thanλ/2 dipole, when use with a copper wire of some 

2m as i element loop, the length of an element, l is l=λx(1.02-1.03). 
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EXPERIMENT PROCEDURE 

1. Set a main controller, transmitting, receiving antenna positioner and computer which are 

main instruments of antenna experiment set. 

2. Set a height controller on a transmitter and fix 500MHz Yagi antenna on an antenna fixing 

pack, then set these on a polarization control  plate. Set an antenna at vertical position 

for earth to get an even polarization characteristic. The transmitting antenna set as Figure  

5-11 get an even polarization characteristic. 

Connect 500MHz oscillation output terminal of main controller and the cable connecting 

terminal of Yagi antenna with SMA cable used for 2m. 

 

Figure 5-11 Even Polarization Transmitting Antenna 

 

3. Fix the full wave circle loop antenna on the polarization control plate of receiver to get 

an even polarization characteristic. Place an antenna to rotating center of receiver by using 

a position control plate of receiver, See Figure 5-12 to set. 

 
Figure 5-12 Setting of Even Polarization Receiving Antenna 

Connect a cable connecting terminal of a full wave circle loop antenna and a RF IN terminal 

of receiver with $MA cable used for lm, and the OUTPUT(1KHz) terminal of receiver and a 

Input(1KHz) terminal of receiver in main controller with BNC cable used for lm. 

3. Calculate the length of a full wave circle loop in 500MHz with below formula,and measure 

 an actual length of antenna and record in Table 5-1. 
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Figure 5 13 Full-Wave Circle Loop Antenna 

 

Table 5-1 Length of Full-Wave Circle [cm] 

 Theoretical Antenna Length Actual Antenna Length 

λ   

 r   

t   

 

5. The length between antennas is isolated as r=l.5m as Figure 5-14. Make a center of each 

transmitting ~ receiving antennas to place in a straight line of same height. 

 
Figure5-14 Distance between Antenna 

6. Set as below in condition of power off. 

  - Power OFF 

  - 500MHz Oscillation Switch off 

  - 2 GHz  Oscillation Switch off 

  - 10 GHz Oscillation Switch off 

  - Modulation Switch (Mod) off 

7. After set a switch in main controller as below, execute the Antenna Trainer program. 

  - Power ON 

  - 500MHz Oscillation Switch on 

  - 2 GHz Oscillation Switch off 

  - 10 GHz Oscillation Switch off 

- Modulation Switch (Mod) on 

 

8. If the program window is executed, execute a data acquisition in Pop Up Menu.Select Antenna 

here and select E-Plane as Plane, then adjust to be displayed 0 in the gain displayer by 

adjusting a signal attenuation. If the adjustment is completed, start a data acquisition. 
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9. After first experiment, save the taken radial pattern by making be this to antenna 1,in data 

box as E-Plane. To confirm the radial pattern exactly, use a data box. Adjust MSP(Max. Signal 

Position) to 0°, can see exactly the radial pattern of this antenna. 

10. Make a polarization control plate to rotate 90~ to get a vertical polarization  

characteristic.Don't change the polarizing direction of a circle loop antenna used for 

receiving. Experiment again and make be Antenna 2 and save this radial pattern in a data 

box as E-Plane. 

 

Figure5-15 Vertical Polarization Transmitting Antenna 

11. Set the full-wave circle loop antenna used for receiving to get a vertical polarization 
characteristic as Figure 5-16. 

 
Figure5-16 Vertical Polarization Receiving Antenna 

 

12. After click Antenna Initialize in Edit Menu of a software, select H-Plane as Plane and click 
 the Auto button for a data acquisition. If the data acquisition is finished, save in a data 

 box of antenna 1. 

 

13. Observe three radial pattern. 

 

13. Set a transmitting, receiving antennas again to get an even polarization characteristic 
respectively. The distance between antennas is r-l.5m. Make the surrounding condition to 

same as the first environment. Take the E Plane radial pattern of a full wave circle loop 

antenna and named Antenna 3 then save in a data box.      

Theoretically, except an effect caused by power damage, this radial pattern must same as 

the first pattern. If the pattern is differ very much, have to do suitably by finding a 

position where the reflection can be occurred. After do suitably, continue the experiment 

and save new pattern in Antenna 3 data box. 

Click the cursor button on Tool window of computer.Two cursors forming the angle of 0° 
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respectively are appeared. The values arranged on right of screen will be changed. These 

indicate a max. value of main beam and a power size(dB) at cursor's position, and an angle 

and cursor's position is displayed at right bottom of window. 

Select a green cursor by dragging. Whenever move this cursor around window,the value of 

cursor 2 is changed. This is an amplitude difference(dB) between max.value and cursor's 

position. 

 

15. Use two cursors to take a half angle of a main beam power in E-Plane pattern of Antenna 

1 data box. 

 

Use below formula to calculate a half-wave beam width in E-Plane of a full-wave circle loop 

antenna. 

 

16. Repeat 14th experiment procedure in a radial pattern of the third data box. 

HPBWE=                  

17. Close an option of cursor. (The window return to the initial screen.) Compare the experimental 

values  with  a  given  values  by  antenna  software. If a calculated values is not 

accorded to this values, experiment and calculate again 

     

 |Ref.] The position of a hal wave beam width take with antenna software though it stray 

from right -3riB point. To observe the cursor's position selected by software, open 

the cursor option then select a pattern you want. Select the Options, Set Cursors 

at -3dB item. The cursor will be placed automatically. Use this item to take fast 

the approximate value of a half power beam width in the next experiment. If you 

necessary, can adjust the to be high accuracy. 

18. Save the data of antenna l, 3 and output the result. Must shows a radial pattern of two 

data box. 

 

Full-Wave Square Loop Antenna 

19. Fix a fu]le-wave square loop antenna on a po]arizatJon control plate of receiver to be got 

an even polarization characteristic. Use a position control plate of receiver to place the 

antenna in rotating center of receiver. See Figure 5-17 to set. 

 

Figure 5-17 Even Polarization Transmitting Antenna 
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Connect the cable connecting terminal of a full-wave square loop antenna to a RE IN terminal 

of receiver with SMA cable used for lm, and connect a OUT PUT(1KHz) terminal of receiver 

to Input(1KHz) terminal of a main controller with BNC cable used for lm. 

 

20. Use below formula to calculate the length of a full-wave square loop and to measure the 

length of an actual antenna in 500MHz, then record in Table 5-2. 

 
Talbe 5-2  Length of Full-Wave Square Loop Antenna [cm] 

 Theoretical Antenna Length Actual Antenna Length 

λ   

 r   

t   

 

21. The distance between antennas is isolated as r=l.5m as Figure 5-18. Set center of each 

transmitting - receiving antenna in a straight line of same height. 

 
Figure 5-18 Distance between Antenna 

22. Set as below in condition of main controller power off. 

    - Power OFF 

    - 500MHz Oscillation Switch off 

    - 2 GHz Oscillation Switch off 

    - 10 GHz Oscillation Switch off 

- Modulation Switch (Mod) off 

 

23. After set a switch in main controller as below, execute the Antenna Trainer program..  

    - Power ON 

    - 500MHz Oscillation Switch on 

    - 2 GHz Oscillation Switch off 

    - 10 GHz Oscillation Switch off 

    - Modulation Switch (Mod) on 

24. If the program window is executed, execute a data acquisition in Pop Up menu. Select Antenna 

here and select E-Plane as Plane, then control to be displayed 0 in an antenna gain displayer 

by adjusting a signal attenuation. If the adjustment is completed, start the data 

acquisition. 

25. After the first experiment, named the taken radial pattern to Antenna 1,and save in data 

box as E-Plane. To confirm  radial pattern exactly, use a data box. If adjust MSP(Max. Signal 

Position to 0°, can see the radial pattern of this antenna. 

26. Make a Yagi antenna used for receiving to rotate 90°the polarization control plate to be 
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got a vertical polarization characteristic. Don't change the polarizing direction of a square 

loop antenna used for receiving. Experiment again, and named Antenna 2 then save this radial 

pattern as E-Plane. 

  
Figure 5-19  Vertical Polarization Transmitting Antenna 

27. Set a full-wave square loop antenna used for receiving to be got a vertical polarization 

characteristic as Figure 5-20. 

 
Figure 5-20 Vertical Polarization Receiving Antenna 

28. After click Antenna Initialize in Edit Menu of a software, select H-Plane as Plane, then 

click the Auto button for a data acquisition. The data acquisition is finished, save the 

pattern in Antenna 1 as file. 

 

29. Observe three radial pattern. 

 

30. Set again the transmitting-receiving antennas to be got an even polarizat characteristic. 

The distance between antennas is r=l.5m. Make the surrounding condition of antenna to same 

as the first experiment. Take the E-Plane radial pattern of a full-wave circle loop antenna, 

save in the data box.     

Theoretically, if except an effect caused by power damage, this radial pattern must same 

as the first pattern. If the pattern is difference ver3, much, have to do suitably by finding 

a position where the reflection can be occurred. After do suitably, continue an experiment 

and save new pattern in Antenna 3 data box. 

Click the cursor button on tool window of a computer. Two cursors making angle of 0°each 

other are appeared. The values arranged at right side of screen will be changed. These 

indicate the max. value of a main beam and the power size of cursor position(dB), and the 

angle and  cursor position  is displayed in the right bottom of the window. 
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Select a green cursor by dragging, Whenever move this cursor around window, the value of 

cursor 2 is changed. This is a difference of amplitude (dB) between max value of a pattern 

and a cursor position. 

 

31. Use two cursors to take a half angle of main beam power size in E-Plane of a data box. 

Calculate a half-power beam width in E-PIane of a full-wave square loop antenna with below 

formula. 

 
32. Repeat 29th experiment procedure in a radial pattern of the third data box. 

 

33. Close an option of cursor.(Window return to the initial screen.) Compare the experimental 

values with give values of an antenna software. If the calculated result is not accorded 

to these values, experiment and calculate again. 

[Ref.| The position of a hal wave beam width take with antenna software though it stray 

 from right -3dB point. To observe the cursor's position selected by software, open 

 the cursor option then select a pattern you want. Select the Options, Set Cursors 

 at -3dB item. The cursor will be placed automatically. Use this item to take fast 

 the approximate value of a half power beam width in the next experiment. If you 

 necessary, can adjust the to be high accuracy. 

 

34. Save the data and output the result. In output, have to present the radial pattern of two 

data box. 

 

Full-Wave Diamond Loop Antenna 

35. Fix a full-wave diamond loop antenna to  be  got  an  even  polarization characteristic 
 on a polarization control plate of receiver. Use the positon control plate of receiver 

 to place an antenna in rotating center of receiver. See Figure 5-21 to set. 

 

Figure 5-21 Even Polarization Receiving Antenna 

   Connect the cable connecting terminal of a full-wave diamond loop antenna and RF IN 

 temainat of receiver with  5MA cable used  for  lm,  and  the OUT PUT(1KHz) terminal of 
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 receiver and the Input(1KHz) terminal in receiver of a main controller with BNC cable used  

for lm. 

 

36. Use below formula to calculate a length of a full-wave diamond loop and measure actual length 
of an antenna in 500MHz, then record in Table 5-3. 

 

    Table 5-3 Length of Full-Wave Diamond Loop Antenna [cm] 

 Theoretical Antenna Length Actual Antenna Length 

λ   

 r   

t   

 

37. Tile distance between antennas is isolated as r=l.5m as Figure 5-22. Make the center of  

a transmitting receiving antennas to be in straight line of same height each other. 

 
Figure 5-22 Distance between Antenna 

38. Set as below in condition of main controller power off. 

    - Power OFF 

    - 500MHz Oscillation Switch off 

    - 2 GHz Oscillation Switch off 

    - 10 GHz Oscillation Switch off 

    - Modulation Switch (Mod) off 

 

39. After set the switch in main controller as below, execute the Antenna Trainer program. 

    - Power ON 

    - 500MHz Oscillation Switch on 

    - 2 GHz Oscillation Switch off 

    - 10 GHz Oscillation Switch off 

    - Modulation Switch (Mod) on 

 

40. If a program window is executed, execute the data acquisition in Pop Up Menu. After select 

Antenna here, select E-Plane as Plane, then control to be displayed 0 in antenna gain 

displayer by adjusting a signal attenuation. The adjustment is completed,start a data 

acquisition. 

 

41. After the first experiment, named the taken radial pattern to Antenna 1, and save it in 

a data box as E-Plane. To confirm a radial pattern exactly, use a data box.Set MSP(Max. 

Signal Position) to 0°, can see a radial pattern of this antenna exactly. 
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42. Make a polarization control plate to rotate 90~ for the Yagi antenna used for transmitting 

get a vertical polarization characteristic. Don't change a polarization direction of a 

full-wave diamond loop antenna used for receiving. Experiment again, named to Antenna 2 and 

save this radial pattern in E-Plane. 

 
Figure 5-23 Vertical Polarization Transmitting Antenna 

43. Set a full-wave diamond loop antenna used for receiving to be got a vertical polarization 

characteristic as Figure 5-24. 

 

Figure 5-24 Vertical Polarization Receiving Antenna 

 

44. After click Antenna Initialize in Edit Menu of a software, select H-Plane as Plane then 

click the Auto button for data acquisition. If a data acquisition is finished, save the 

pattern in Antenna 1 as file. 

 

45. Observe three radial pattern. 

 

46. Set again the transmitting, receiving antenna to be got an even polarization characteristic. 

 The distance between antennas is r=l.5m. Make a surrounding condition of antenfia to same 

 as the first experiment. Take the E-Plane radial pattern of a full-wave diamond loop antenna, 

 and save in data box. 

     Theoretically, except an effect caused by power damage, this radial pattern must same as 

 the first pattern. If the pattern differ very much, have to do suitably by finding a position 
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where the reflection can be occurred~ After do suitably, continue the experiment and named 

the new pattern to Antenna 3 then save in data box. 

Click the cursor button on tool window on computer. Tow cursors making the angle of 0°are 

appeared. The values arranged on right side of a screen will be changed. These indicate the  

max. value of a main beam and a power size(dB) at cursor position, and the angle and cursor  

position is displayed in the bottom of window. 

    Select the green cursor by dragging. Whenever move this cursor, the Value of cursor 2 is changed. 

This is a difference of amplitude between max. value of the pattern and cursor position. 

 

47. Use tow cursors to take an half angle of main beam power size in E-Plane pattern of a data 

box. Calculate a half-wave beam width in E-Plane of a full-wave diamond loop antenna with 

below formula. 

 
 

48. Repeat No. 44 of experiment procedure in radial pattern of the third data box. 

 

49. Close an option of cursor. (Window return to the initial screen.) Compare the experimental 

  values with  the given  values~  if the  calculated  result  is  not accorded to these 

values, experiment and calculate gain. 

[Reference]  The position of a hal wave beam width take with antenna software though it 

             stray from right -3dB point. To observe the cursor's position selected by 

             software, open the cursor option then select a pattern you want. Select the 

             Options, Set Cursors at  3dB item. The cursor will be placed automatically. 

             Use this item to take fast the approximate value of a haft power beam width 

             in the next experiment. If you necessary, can adjust the to be high accuracy. 

50. Save the data and output the result. In output, must shows the radial pattern of two data 

box. 
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EXERCISE 

 

1. Express the current distribution raging along lead of a full-wave loop antenna by drawing. 

                                                                                         

                                                                                         

2. Make clear that the infinitesimal loop antenna and the infinitesimal loop antenna is 

 duality. 

                                                                                         

                                                                                         

3. Try to draw the radial pattern the circle, square and diamond full-wave loop antenna 

respectively and explain the difference. 

                                                                                         

                                                                                         

3. Explain what is the polarization characteristic with a circle, square and diamond 

   full-wave loop antenna respectively. 
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EXPERIMENT3-6 YAGI ANTENNA 

Let's measure a radial pattern in E Plane and H-Plane for Yagi antenna. We will study the 

polarization characteristic of Yagi antenna. Let's calculate a half-power beam width of Yagi 

antenna. 

 

BASIC STUDY 

1. YAGI ANTENNA 

As the Yagi antenna is an antenna invented by Dr. Yagi and Uda, it is most representative 

antenna for endfire array. 

It is in 1930 that this Yagi antenna is used for a wireless telephone of VHF mark. Since 

generally the Yagi antenna has a simple structure and high quality function as a beam antenna, 

it is used in place of VHF, UHF mainly. 

 

  1.1 Operation of Parasitic Element 

Figure 6-1 shows a 3 element Yagi antenna to be got a good characteristic and having a simple 

structure.  There are a central element connected  with a transmitter(or receiver) by feeder, 

that is radiator, and a reflecter and director leaving a space of 2/4 at the front and rear, 

and these are the parasitic element which is not connected with transmitter. 

 

Figure 6-1 3 Element Yagi Antenna 

Let's know why does these parasitic element is operated as a reflector or director. Let's give 

an example with operation of a reflector. 

It is suppose that place little longer reflector than λ/2 space out ,λ/4 at left side of 

a radiator as Figure 6-2(A). 

 

(A) 2 Element Yagi                    (B) Flow Chart about Operation of a Parasitic 
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Antenna attached Reflector                 Reflector(See main text) 

       Figure 6-2 Operation of Parasitic Element(In case of Reflector) 

In this case, what the phase is delayed 90°till an electron wave radiated from radiator reach 

to the reflector and  the phase  of current(Iref) flowing into reflector(To be inductive 

reactance because of a length is little longer than λ/2) is to be more delayed 90°than the 

radial field in a radiator. And the electron wave reradiated from reflector is to be delayed 

again 90°phase since the current flowing through a reflector delay 90°.Though this is a 

very particular, but to be as Figure(B) by indicating in vectorial. That is, the phase of an 

electron wave radiated from reflector(Field Eref)(Status not radiated from reflector yet) 

becomes finally  more delayed  270°than the electron wave(Field Erad) radiated from radiator, 

this means that Eref precede 90°the phase more than Erad. 

During Eref process to ahead that is, toward a radiator and reach the point of radiator, also 

a phase is delayed 90°. Therefore E′ref is added by becoming a same phase with Erad so can 

see that the electron wave in direction of ahead becomes strong. 

Oppositely for the rear direction, since E′rad reached from a radiator becomes more delayed 

90°than Eref as the first explanation, it becomes inverse phase with Eref and is attenuated. 

So when the size of E′rad and Eref is same, the radiation at rear direction becomes 0. 

Think like this, in the case of a little shorter director than λ/2, the operation is explained 

in the same way if consider that the phase of Idir is more precede 90°than E'rad. Actually 

the spacing between the radiator and the parasitic. 

element is not always limited as /1/4. Because of the mutual impedance between elements and 

they give an effect each other, it is not simple as above explanation. 

According to the length, thickness and spacing between elements, the characteristic of an 

actual antenna is changed complexively. 

 

1.2 Multi-Element Yagi Antenna 
As the original Yagi antenna is an replaced antenna of VHF, UHF, it is useful to arrange many 

parasitic elements in the directivity and gain of an Yagi antenna since the physical size is 

not large so much. 

Only, as above explanation, if arrange over 4 element, the characteristic of an antenna becomes 

complex as impossible as the exact indication with computer.Therefore show the design of the 

mult-element Yagi antenna taken experimentally here. 

Also it is the shape of an antenna which place one reflector at rear of a radiator and place 

the entire element at front of a radiator as a director. 

 

(1) Relation between Element Number and Gain 

Figure 6-3 shows the relation between the element number and gain, and according to the gain 

wanted, the element number is decided. Figure 6-4 shows the relation between the length at 

axis direction of element arrangement(Whole Length of Array) and gain. If becomes over 6 

element, the increasing of gain is decided by length at axis direction of array than element 

number. To increase the gain to 2times(Increase 3dB), can not help increasing about 2times 

the length at axis direction of array. 
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               Element Number                             Yagi Element Number 

Figure 6-3 Relation between             Figure 6-4 Relation between Length of 

              Element Number and Gain.                   Antenna and Element Number 

 

(2) Element Spacing 

Figure 6-1 shows each element spacing in the case of 2-8 element and over 9 element. When 

make each element to the most proper length, the change of gain is within ldB. 

 

 

(3) Length of Director 

When make No.l, NO.2......in order from the most near element from a radiator, if the diameter 

of element in Figure 6-5, can take the most suitable length of each director. 

 

Figure 6-5 Method taking each Director 

The length of a radiator has not relation almost to the characteristic of an antenna, and 

the length of reflector is not important so much in over 4 element.Therefore set to the said 

length in 3 element then have only to adjust later on. 
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Yagi antenna or Yagi- Uda antenna is named for Prof. H.Yagi and Lab. S.Uda experimenting the 

parasitic array in Japan, 1920. 

This antenna is designed by the idea that since each antenna has own current distribution, 

if superpose each antenna, the multi antenna can be constructed.The radial pattern of this 

multi antenna is a result from the addition and difference of an electron wave radiated from 

currents distributed to each antenna. 

In a folded dipole antenna, the radial pattern for the special direction is increased by being 

added each other the current distribution of 2 lead near by each other. Also between the current 

distribution of a loop antenna, that is between the currents distributed at each point of 

a loop antenna at a distance of same distance, making the proper radial pattern by being added 

and subtracted each other. The pencil beam-radiation pattern is generated in Herical antenna 

by an effect that the wave progressing form one loop of open wire to another loop is added  

each other. 

These are the examples for the driving antenna array effect,that is the effect arraying the 

numerous antenna elements connected with feed circuit by any type. Like this, it is called 

the antenna constructed with various antenna element to the antenna array. 

This array effect can be got by using the parasitic antenna element. This parasitic antenna 

element is a conductor or lead which are not connected with feed circuit. In this case, the 

array effect caused by the current induced to the parasitic antenna element by an electron 

wave. This parasitic antenna elements becomes  excited  by  Near-field  coupling  radiated 

from a driving antenna element(Launcher). 

 

2. Basic Principle of Yagi Antenna 

Figure 6-6 shows the Yagi antenna having a 6 antenna element. 

 
Figure 6-6 6 Antenna Element Yagi Antenna 

The Yagi antenna consists of a constituent as follows. 

–Driving Antenna or Radiator connected with a feed circuit. 

  As this is an antenna element fed directly from a transmitter, can use an antenna element 

of different type such as a half-wave dipole or folded dipole antenna, 

–Reflector placed on one side of a driving antenna element. 

  Make a radial power to reflect again toward,a driving antenna. Theoretically can place 

several reflector with same spacing and length. But actually one reflector is accepted 

generally because of the merits of the reflector over one is not much. 

–Director placed on one different side of a driving antenna element. 

  It is means that the parasitic antenna elements over one operating connection of a radial 

power. Actually the several directors are used for the Yagi antenna, and it is shorter as 
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distance from a radiator, make it to isolate with little shorter spacing. 

The reflector is longer as 5% than a driving antenna element, and the first inductor is shorter 

as 5%. The optimum spacing for the Yagi antenna get a max. directivity is when the driving 

antenna element, reflector and the first inductor is within 0.15λ-0.25λ respectively. When 

use  several  inductors, the remained inductors is little short, and it is isolated with 

little distance spacing. The spacing of a driving antenna element, reflector and the first 

inductors have an effect on an impedance matching. But the spacing between antenna elements 

has not an effect so much on the change. The effect of a driving antenna element for a parasitic 

antenna element nearby is what can induce the current that the phase becomes inverse with 

the size of an incident wave being same almost for the parasitic antenna elements. 

It has a merits that the antenna gain is increased if have the inductor over one.But as increase 

the number of a inductor, the merits is disappeared little by little. Because of the parasitic 

inductor far away from the driving antenna element and the induced current organized to a 

parasitic inductor becomes decreased. So the degree contributing to the antenna gain is to 

be weak little by little. 

This relation is given in Figure 6-7 and Table 6-2. 

    
Figure 6-7 Relation between  

the Number of all element of Yagi Antenna and Gain 

Table 6-2 Gain of Yagi Antenna according to the Number of Array Element (Spacing=l.5λ) 

Elements Gain 

3 8.7 

4 9.9 

5 10.5 

6 11.1 

The input impedance of Yagi antenna is a function of input impedance of a radiator but it 

is affected very much from a parasitic elements. It is easy to take that the theoretical input  

impedance for a 3 element dipole alTay is about 2552. The change of a input impedance according 

to the antenna structure is large comparatively, and the values from 2052 to 10052 are often 

used. Like know as above discuss, Yagi antenna is one type on antenna structure not special 

antenna model. Actually there are various transforulation of Yagi antenna. Since the easy 

method to analysis the Yagi antenna, the analysis and ol)timize for this antenna do always 

with computer calculation and simulation. Fortunately many experimental and numerical studies 

have been doing, the results are recorded in the thesis, text book and technical book 

etc. 
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EXPERIMENT PROCEDURE 

Setting of Experiment Instrument 

1. Set the main controller, transmitting, receiving antenna positioner and computer which are 

 main instruments of the antenna experiment set. 

2. Set a height control bar on a transmitter and fix 500MHz Yagi antenna on the antenna fixing 

 pack then set this on the polarization: control plate. In this time, set this to be even 

 with earth for an antenna get an even polarization characteristic. The transmitting 

 antenna set as Figure 6-8 get an even polarization characteristic.Connect the 500MHz 

oscillation output terminal of main controller and the cable connecing terminal of Yagi 

antenna with SMA cable used for 2m. 

 
Figure 6-8 Even Polarization Transmitting Antenna 

3. Fix the 500MHz Yagi antenna to get an even polarization characteristic on the polarization 

 control plate of a receiver.  Use the position control plate of a receiver to place an antenna 

 in rotating center of a receiver. See Figure 6-4 to set. 

 

Figure 6-9 Setting of Even Polarization Receiving Antenna 

 Connect the Yagi antenna and RF In terminal of a receiver with SMA cable used  for  lm,  and  

 connect OUT PUT(1KHz) terminal of a receiver and Input(1KHZ) in receiver of main controller 

 with BNC Cable used for lm. 

4. Use below formula, calculate the length of Yagi antenna and measure the actual length of 

 antenna in 500MHz then record in Table 6-2. The exact oscillation frequency of RF signal 

generator is 500MHz. 
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Figure 6-10 Yagi Antenna 

Table 6-2 Length of Yagi Antenna [cm] 

 

5. As Figure 6-11,the distance between antennas' is isolated as r=l.5m. Make a center of each 

transmitting, receiving antennas to place in a straight line each other. 

 
Figure 6-11 Distance between Antennas r 

6. Set as below in condition of turning off the power of main controller. 

   - Power OFF 

   - 500MHz Oscillation Switch off 

   - 2 GHz Oscillation Switch off 

   - 10 GHz Oscillation Switch off 

   - Modulation Switch (Mod) off 

7. After set a switch in main controller as below, execute the Antenna Trainer program. 

    - Power ON 

    - 500MHz Oscillation Switch on 

    - 2 GHz  Oscillation Switch off 

    - 10 GHz Oscillation Switch off 

- Modulation Switch (Mod) on 

8. The program window is executed, execute Data Acquisition in Pop Up menu. 

Here after select Antenna, select E-Plane as Plane and control to be displayed 0 in gain 

displayer by adjusting the signal attenuation. The adjustment is completed, start Acquisition. 

9. If the data acquisition is completed, save the taken radial pattern in file. Use the data 

box to confirm a radial pattern exactly. If set MSP(Max. Signal Position) to 0°, can see 

the radial pattern of this antenna. 
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10. Make the control plate to rotate 90~ for the 500MHz Yagi antenna used for transmitting get 

a vertical polarization characteristic by loosing the screw on the polarization control 

plate.        

 
Figure 6-12 Setting of Vertical Polarization Transmitting Antenna 

11. Set as Figure 6-13 for Yagi antenna used for receiving get a vertical polarization 

  characteristic. 

 

Figure 6-13 Setting of Vertical Polarization Receiving Antenna                                                                                                                      

12. Click Antenna Initialize in Edit Menu of a software, click the Auto button to data acquisition. 

If the data acquisition is finished,after select H-Plate as Plane, save the pattern in 

file. 

13.  Keep the 500MHz  Yagi  antenna used  for transmitting  to get a vertical polarization 

characteristic and set as Figure 6-9 for the Yagi antenna used for receiving get a vertical 

polarization characteristic. 

14. Click Antenna Initialize in Edit Menu of a software, and click again Delete Screen then 

click the Auto button to data acquisition. 

15. Observe three radial pattern. 

16. Set a transmitting, receiving antennas get a vertical polarization characteristic 

respectively. The distance between antennas is r=l.5m. Make a surrounding condition of  

antenna to be same as the first experiment. Take the E-Plane radial pattern of an Yagi antenna 

and save in Dummy-Plane. 

Theoretically if except an effect caused by a power damage, this radial pttern has to be  

same as the first pattern. If the pattern is different very much, have to do suitably by 

finding the position where a reflection can be occurred. After do suitably, continue an 

experiment and save new pattern in E-Plane. 
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Click Data Indicating Line in View Menu of upper menu of a data analysis program. Two 

cursors(Blue, White) used for E-Plane and tow cursors(Yellow, Green) used for H-Plane are 

appeared on the screen. If click an arrow on both side of a displayer of each color, the 

values in the displayer will be changed by moving the cursor of same color. These indicate 

the angle of cursor position and the receiving power in that time as dB, show the difference 

of angle between cursors and power in below 2 displayer. 

Record the values in below Table 6-3. 

Table 6-3  Receiving Power for Angle 

Angle 

 
0° 

30

° 
60° 90° 120° 150° 180° 210° 240° 270° 300° 330° 

Receiving 

Power of 

E-Plane 

for Angle 

            

Receiving 

Power of 

H-Plane 

for Angle 

            

17. Use the cursor to take the receiving angle of max. power in E-Plane pattern and the receiving 

power in that time. Click the Maximum Single Level button on the E-Plane data window to 

confirm if a measured value is accorded to a taken value with cursor. Record this in Table 

6-3. 

Table 6-4 Comparison of E-Plane with Theoretic Value 

Receiving Power  Taken Value 

With cursor Angle  

Receiving Power  Value by 

Maximum Single Icom Angle  

18. Take a half angle of main beam power in E-Plane pattern by using a cursor. Click the Half 

Power Beamwidth button on data window to confirm if same the measured value with button 

as taken value with cursor. 

Calculate a half-power beam width of Yagi antenna in E-Plane with below formula. 

 
19. Repeat No. 18 of the experiment procedure in H-Plane radial pattern. 

 

20. Delete all cursors by clicking the data indicating line in view menu. Compare the experimental 

 values with given value in the antenna  software. If the calculated result is not accorded 

 to this values, experiment and calculate again. 

21. Save the E-Plane and H-Plane data and output the result. 

22. After remove L1, L2, L3 in Figure 6-10 and make 3 element antenna, complete below table 

by repeating item 1-21. 

Table 6-5 Characteristic of 3 Element Yagi Antenna 
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23. After couple L3 in Figure 6-10 and make 4 element Yagi antenna, complete below table by 

repeating item 1-21. 

Table 6-6 Characteristic of 4 Element Yagi Antenna 

 

24. After couple L2 in Figure 6-10 and make 5 element Yagi antenna, complete below table by 

repeating item 1-21. 

Table 6-7 Characteristic of 5 Element Yagi Antenna 

 

25. Complete below table by synthesizing the experiment up to now. 

Table 6-7 Characteristic of Yagi Antenna according to the number of Element 
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EXERCISE 

1. Figure the driving principle of Yagi antenna by electron field. 

                                                                          

                                                                          

2. Make clear the manufacturing way and electric characteristic of a radiators,reflectors 

and inductors. 

                                                                          

                                                                          

3. Explain the relation between the number of element and gain of Yagi antenna. 

                                                                          

                                                                          

4. Explain about the radial pattern of Yagi antenna. 

                                                                          

                                                                          

5. What's the polarization characteristic of Yagi antenna. 
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EXPERIMENT3-7 SPIRAL ANTENNA 

 

Let's measure a radial pattern for E-Plane and II-Plane of a spiral antenna in this experiment. 

We will study about a polarization characteristic of a spiral antenna. Let's calculate a 

half-power beam width of a spiral antenna by using antenna software 

 

BASIC STUDY 

1. Spiral Antenna 

The spiral antenna having wide band is introduced by V.H Rumsey in 1957, later J.D Dyson gives 

proof experimentally that the plane equiangular spiral, and conical spiral antenna etc. have 

an independent characteristic of frequency in 1959. 

Generally if the frequency of antenna is changed, the physical size of antenna is changed. 

Accordingly if the physical size of antenna is decided, the ranged of using frequency can 

not help limiting. But as a spiral antenna is what make an antenna arm to rotate exponential 

functionally, it can be used in wide band because can replace the change of physical size 

to the change of rotating angle. And the characteristic impedance and radial pattern has a 

frequency independence not changed in wide frequency band, and it has the characteristic of  

small size , lightweight and non-directivity. So it is used widely for the air communications, 

radar system and receiving antenna of civilian satellite etc. 

 

1.1 Geometrical Structure of Spiral Antenna     
As the spiral antenna of all frequency independent antenna, there are Conical Spiral, 

Log Periodic Antenna and Equiangular Spiral Antenna etc. 

The equiangular spiral antenna has a characteristic that the distance from a starting 

point to optional point is increased exponential functionally for spin angle, and also 

has a structure that the arm rotate as 180°and expand. For this antenna, the radiation 

is occurred strongly if the traveling wave in arm becomes same phase in lead element 

nearby,  and the radiation  is  not occurred by attenuating if becomes an inverse phase. 

 
Figure 7-1 2Arm Equiangular Spiral Antenna 

The geometrical structure of a spiral antenna is taken by below formula. 
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where, a: Spiral Constant 

         r0: Radius in Antenna Feed 

         pl: Distance from starting point of P arm to outside wire. 

         p2: Distance from starting point of P arm to inside wire. 

         P3: Distance from starting point of Q arm to outside wire. 

         p4: Distance from starting point of Q arm to inside wire. 

          Ф : Spin Angle from starting point. 

          δ: Rotary Angle 

a is Spiral Constant deciding the expansion of antenna. If the value a is little,the 

expanding speed becomes lower, and if the value a is large, the expanding speed becomes 

faster. Accordingly if the value a is to be large,the arm becomes little relatively and 

the value a is little, the length of arm becomes longer, r. decide max. frequency, and 

the rt decide lower frequency. 

The relation of a driving frequency and radius is as below. 

 

Accordingly the frequency band of antenna is as below. 

 

c: Spread Speed of Electron Wave in Free Space. 

The spin distance of a spiral antenna from starting point to optional point on antenna 

is as below. 

 

1.2 Radial Pattern 

The spiral antenna has a circle polarity and bilateral beam pattern, and the type of 

this radial pattern is not changed almost according to the frequency change.If the field 

polarity of radiational pattern, can regards it as a threshold deciding the band width 

offset, and the band width, ratio of upper frequency and lower frequency, becomes over 

20:1. 



 83 

 
Figure 7-2 Coordinates System of Antenna and Radial Electron Field 
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EXPERIMENT PROCEDURE 

1. Set the main controller, transmitting-receiving antenna positioner and computer which are 

 main instruments of the antenna experiment set. 

2．Set a height control bar on a transmitter and fix 500MHz Yagi antenna on the antenna fixing 

 pack then set this on the polarization control plate. In this time, set this to  be even  

with  earth for an  antenna  get an even  polarization characteristic. The transmitting 

 antenna set as Figure 7-3 get an even polarization characteristic. 

Connect the 500MHz oscillation output terminal of main controller and the cable connecting 

terminal of Yagi antenna with SMA cable used for 2m. 

  

Figure 7-3  Even Polarization Transmitting Antenna 

3. Fix the 500MHz Yagi antenna to get an even polarization characteristic on the polarization  

control plate of a receiver.  Use the position  control  plate of a receiver to place an 

antenna in rotating center of a receiver. See Figure 7-4 to set. 

 
 Figure 7-4 Setting of Even Polarization Receiving Antenna 

  Connect the Yagi antenna and RF In terminal of a receiver with SMA cable used for lm,  

and connect OUT PUT(1KHz) terminal of a receiver and Input(1KHZ) in receiver of main 
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controller with BNC Cable used for lm. 

4. As Figure 7-5, the distance between antennas is isolated as r=l.5m. Set the transmitting 

receiving antennas at opposite position of same height. 

                          

Figure 7-5 Distance of Antennas r 

5. Set as below in condition of turning off the power of main controller. 

   - Power OFF 

   - 500MHz Oscillation Switch off 

   - 2 GHz Oscillation Switch off 

   - 10 GHz Oscillation Switch off 

- Modulation Switch (Mod) off 

 

6. After set a switch in main controller as below, execute the Antenna Trainer program. 

        - Power ON 

        - 500MHz Oscillation Switch on 

        - 2 GHz Oscillation Switch off 

        - 10 GHz Oscillation Switch off 

        - Modulation Switch (Mod) on 

7. The program window is executed, execute Data Acquisition in Pop Up menu. Here after select 

Antenna, select E-Plane as Plane and control to be displayed 0 in  gain  displayer  by  

adjusting  the  signal  attenuation. The adjustment is completed, start Acquisition. 

8. If the data acquisition is completed, save the taken radial pattern in file. Use the data 

box to confirm a radial pattern exactly. If set MSP(Max. Signal Position) to 0°, can see 

the radial pattern of this antenna. 

 

9. Make the control plate to rotate 90" for the 500MHz Yagi antenna used for transmitting 

get a vertical polarization characteristic by loosing the screw on the polarization control 

plate. 
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Figure 7-6 Setting of Vertical Polarization Transmitting Antenna 

10. Make a center of a spiral antenna used for receiving to be vertical with a rotary axis, 

and set as Figure 7-7 to get a vertical polarization characteristic. 

11. Click Antenna Initialize in Edit Menu of a software, click the Auto button to data 

acquisition.If the data acquisition is finished, after select H-Plane as Plane, save the 

pattern in file. 

 
Figure 7-7 Vertical Polarization Receiving Antenna 

12. Keep the 500MHz Yagi  antenna used  for transmitting  to get a vertical polarization 

characteristic and set the spiral antenna used for receiving to get a vertical polarization 

characteristic. 

13. Click Antenna Initialize in Edit Menu of a software, and click again Delete Screen then 

click the Auto button to data acquisition. 

14. Observe three radial pattern. 

15. Set a transmitting. receiving antennas get a vertical polarization characteristic 

    respectively. The distance between antennas is r=l.5m. Make a surrounding condition of 

antenna to be same as the first experiment. Take the E-Plane radial pattern of a spiral 

antenna and save in Dummy-Plane. 

  Theoretically if except an effect caused by a power damage, this radial pattern has to 

be same as the first pattern. If the pattern is different very much, have to do suitably 

by finding the position where a reflection can be occurred. After do suitably, continue 

an experiment and save new pattern in E-Plane. 
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Click Data Indicating Line in View Menu of upper menu of a data analysis program.Two 

cursors(Blue, White) used for E-Plane and tow cursors(Yellow,Green) used for H-Plane are 

appeared on the screen.If click an arrow on both side of a displayer of each color,the 

values in the displayer will be changed by moving the cursor of same color. These indicate 

the angle of cursor position and the receiving power in that time as dB, show the difference 

of angle between cursors and power in below 2 displayer. Record the values in below Table 

7-1. 

 

 

 

 

 

Table 7-1 Receiving Power for Angle 

Angle 

 
0° 30

°
 60° 90° 120° 150° 180° 210° 240° 270° 300° 330° 

Receiving 

Power of 

E-Plane 

For Angle 

            

Receiving 

Power of 

H-Plane 

For Angle 

            

16. Use the cursor to take the receiving angle of max. power in E-Plane pattern and the receiving 

power in that time. Click the Maximum Single Level button on the E-Plane data window to 

confirm if a measured value is accorded to a taken value with cursor. Record this in Table 

7-2. 

  Table7-2 Comparison of E-Plane and Theoretic Value 

Receiving Power  Taken Value 

With cursor Angle  

Receiving Power  Value by Maximum  

Single Level Icom Angle  

17. Take a half angle of main beam power in E-Plane pattern by using a cursor. 

  Click the Half Power Beamwidth button on data window to confirm if same the measured value 

with button as taken value with cursor. 

  Calculate a half-power beam width of spiral antenna in E-Plane with below fomaula. 

 

18. Repeat No. 17 of the experiment procedure in H-Plane radial pattern. 

 

19. Delete all cursors by clicking the data indicating line in view menu. Compare the 

experimental values with given value in the antenna software. If the calculated result 

is not accorded to this values, experiment and calculate again. 

 

20.  Save the E-Plane and H-Plane data and output the result. 

 

21. Set the switch in main controller as below. 
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    - 500MHz Oscillation Switch off 

    - 2 GHz Oscillation Switch on 

    - 10 GHz Oscillation Switch off 

    - Modulation Switch (Mod) on 

 

22. Repeat the experiment procedure 8-20 on same spiral antenna fed 2GHz. 

 

23. Compare the radial pattern fed each 500MHz and 2GHz to same spiral antenna. 
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EXCERClSE 

1. What's the wide band antenna? 

                                                                        

                                                                        

2. Explain the basic concept for use the spiral antenna as the wide band antenna. 

                                                                        

                                                                        

3. Are there the difference between a radial pattern of a spiral antenna and of a dipole antenna ? 

Explain the difference and the reason occurred it. 

                                                                        

                                                                        

4. Explain the usage of a spiral antenna. 

                                                                        

                                                                        

5. What's the polarization characteristic of a spiral antenna? 
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EXPERIMENT3-8 HERICAL ANTENNA 

Let's measure the radial pattern for E-Plane and H-Plane of a Herical antenna used for 10GHz 

in this experiment. We will study the polarization characteristic of a Herical antenna. Let's 

calculate a half-pawer beam width of a Herical antenna by using an antenna software. 

BASIC STUDY 

1. Circularly Polarized Wave 

The preceding experimented antennas is what have a linear polarization characteristic.In the 

case of the straight wire antenna such as a dipole, folded dipole and monopole, the radiated 

field becomes same as a direction of physical wire. For example, in the case of a transmitting 

plane dipole, the field is on plane and the magnetic field is on vertical plane. This antenna 

is able to receive most largely the wave which the field is on plane. 

Also the loop antenna has a linear polarization characteristic. For example, the vertical 

full-wave loop antenna fed from floor does function like an even dipole,radiates the wave 

type of even polarization. Perhaps, if feed not from floor but from right or left side, the 

radial wave type is to be vertical polarization, The square waveguide transmit a linear 

polarized wave type. In prior experiment of measurement for E-Plane and H-Plane, you can 

confirm that must use all the same polarization. If two transmitting.receiving antenna is 

arranged tightly and control the steering direction to get same polarization characteristic, 

becomes accept well the signal. But if one antenna of two rotate 90°, becomes receive a weak 

signal for the cross-polarization isolation. Theoretically since the cross-polarization 

isolation is large unlimitedly, any signal must not be received. But actual cross-polarization 

isolation is not to be unlimited. 

There are an elliptically polarized wave and circular polarization in kind of a pohuization 

of an antenna. The elliptically polarized wave is generated by the collate of two field 

vector(regards two vectors as different tow linear polarization each other). Two vectors are  

placed vertically each other, have same frequency and travel toward same direction. But their 

amplitude and phase have a different value respectively. If the amplitude of two vectors is 

same respectively and have a phase difference of 90~ exactly, becomes a circular polarization. 

If the amplitude of one vector or other vector is 0, becomes a linear polarization. It can 

regards that the linear polarization and circular polarization is the special case of an 

elliptically polarized wave. 

To be a circular polarization, must make the field to rotate rapidly according to travel the 

wave. There can be many ways to generate the circular polarization.One thing is what radiate 

together an even polarization wave having the phase difference of 90~ with a vertical 

polarization  wave.  This is similar to draw Lissajous pattern of perfect circle as input 

a sine wave having a phase difference of 90°for X, Y axis input by Osiloskov. 

Another way is what send the electron wave along the helix lead of proper size.Since the wave 

move along helix, make the field rotating rapidly. This principle is applied to the helix 

antenna. The rotation of field is one of clockwise and counterclockwise. If the field rotate 

to right finger when the thumb indicate toward traveling direction by grasping right hand, 

this polarization is called right circular polarization. 

If opposite direction, it is called left circular polarization. The cross-polarization 

isolation in circular polarization weigh  heavily. The right circular polarization antenna 
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can not receive the signal to be left circular polarized. The inverse also is effected. But 

each antenna get offset a little the signal to be linear polarized toward optional direction 

and can receive. 

Although the linear polarization is used in major case, the circular polarization would be 

used very usefully according to the communication system. For one example, it is difficult 

to maintain a direction of antenna regularly in the satellite communication system. 

Accordingly the linear polarization in this case becomes receive a fading. If use a circular 

polarization,the strength of receiving signal becomes regular almost regardless a direction 

of satellite antenna. 

 

2. Herical Antenna 

Figure 8-1 shows a typical axial-mode of a herical antenna. That is the herical antenna is 

designed to radiate the electron wave from grounding plane toward helix axis, and to have 

a radial pattern of pencil-beam type rotating toward coiled direction of a helix. The herical 

antenna of this type has a merits which easy to match as the wide band and input impedance 

is about 120Ω-140Ω as well as has a very efficient radial pattern. 

 

(A) Plane (Geometry)   (B) Radial Model of Pencil-beam 

Figure 8-1 Axial-mode Herical Antenna 

The initial letter used to draw helix. 

   N = Number of Rotation(Over 3times) 

   S = Space of Rotation = C tanа 

   pitch, distance between the centers of a helix that is, rising height when 1 rotate

（1/10~1/2 λ）    

A = Axial Length = NS 

    D = Diameter of Helix 

    d = Diameter of Conductor(Lead) 

    L = Length of Rotation 

    (About = лD, 3/4~4/3λ) 

    a = pitch angle = tan 
-1
(S/C) 

   pitch angle of helix a 

The herical antenna becomes radiate an electron wave in axial mode when the circumference is 
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given about length of one wave. The using frequency range of a herical antenna is given as 

formula (8-1). 

 

The sine wave travel from grounding plane toward opposite end point along helix . Therefore 

the herical antenna is called a traveling wave antenna. 

To understand the operating principle of a herical antenna, consider one helix loop of λ 

circumference as Figure 8-2. As the circumference of helix in optional moment tl isλ, the 

current is a positive value(+) in one plane of loop, and negative value(-) in opposite value. 

As show in figure, can connect I
+
 point and I

- 
point with arrow mark in same geometric direction, 

and this makes to act alike dipole of one kind. 

In t2, after short time, the current moves as short distance along helix. Now the dipole becomes  

a shape rotated a little. That is, this imaginary dipole becomes rotate identically with each 

frequency(o2) of a transmitted wave type. In Figure 8-2, the radial pattern toward both sides 

will be 0. The radiation of electron wave will be only toward axial direction of a helix. 

 
 Figure 8-2 One Loop of Herical Antenna 

If each loop forming helix is all folded and is same phase, it is going to get a strong radial 

pattern along both axis of helix as Figure 8-3. But Figure 8-3 isn't a radial pattern of herical 

antenna in axial mode. Since the phase difference is generated by occurring a propagation 

delay along helix, for the radial pattern, two lobes are not generated but one lobe toward 

axis. 

The herieal antenna has similar radial pattern to the end-fire antenna taking unique lobe 

toward endfire because the position of antenna array elements and the phase of feed current. 

The coiled direction of helix decide a direction of circular polarization. When set,helix 

in side of grounding plane, the coiling toward clockwise makes right circular polarization 

to generate and toward counterclock wise makes left circular polarization to generate. 

 

Figure 8-3  Radial Pattern of Pencil Beam 

3. Axial Ratio and Gain 

When receive the signal to be circular polarization, the response of herical antenna has to 

maintain as identical size ideally though the field of receiving signal is rotated. To explain 

this, consider the case using the antenna to be circular polarization like dipole as a 

transmitting antenna, and using the herical antenna as receiving antenna. The polarization 

of transmitting signal will be changed by rotating dipole. The ideal herical antenna must 
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get same receiving level for all direction of a dipole that is for all polarization. But the 

radial characteristic of a herical antenna can be assymmetry a little because a helix has 

a limited size.Accordingly the receiving characteristic for the polarization of special 

direction can be appeared somewhat better than for other direction. 

Here the response index of a polarization toward special direction for a polarization toward 

other direction is called the axial ratio of a herical  antenna or the circularity. This gives 

a definition with a ratio between amplitudes indicating max response and an amplitude of 

polarization indicating min. response. It can be said that the antenna responding same for 

all polarization has axial ratio of 1.0(or 0dB).The axial ratio is given as below. 

 
where AR is an axial ratio 

      N is a number of helix 

The axial ratio can be measured through a receiving and transmitting between antennas to be 

direct polarization with a herical antenna. If measure max and min. amplitude by rotating 

one antenna, the axial ratio can be calculated with two amplitude ratio directly. Ideally, 

the herical antenna take a value between axial ratio 1 and 1.1(0 and 0.83dB). To take these 

result, must make the open end of helix to grow less little by little. It is not easy to get 

an axial ratio of some 1.12(ldB) for the helix of an actual regular diameter, if indicate 

the gain of a herical antenna based on experiment, as below. 

 

 

4. Normal Mode 

The herical antenna taking the different radial pattern entirely can be made as Figure 8-4. 

This herical antenna is driven with normal mode, the max. radial direct is vertical with an 

axis of antenna.  

In normal mode driving, the circumference of helix must less in proportion to the wave. Because 

make the current to distribute into the phase and amplitude almost identically along helix. 

The .helix of this type has a low electric length and low efficiency. 

 
(A) Geometric Structure    (B) Radial Pattern 

Figure 8-4  Normal Mode Herical Antenna 
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EXPERIMENT PROCEDURE 

1. Set a transmitting, receiving antenna positioner and a computer which are main instrument 

 of an antenna experimental set. 

2. Fix 10GHz Horn antenna on the polarization control plate in transmitter. Set it to be even 

with earth to get an even polarization characteristic. The transmitting Horn antenna as 

Figure 8-5 gets an even polarization characteristic. Connect 10GHz oscillation output 

terminal  in  main  controller and Cable connecting terminal of Horn antenna with SMA cable 

used for 2m. 

 
Figure8-5 Setting of Even Polarization Horn Antenna 

3. Fix the Herical antenna on the polarization control plate in receiver to measure an axial 

mode radial characteristic. Use the position control screw in receiver, place the ground 

plane to be vertical with a rotary axis in receiver. See Figure Figure8-6  Setting of Axial 

Mode Herical Antenna Connect the Herical antenna and RF In terminal of a receiver with SMA 

cable used  for  lm,and connect OUT PUT(1KHz) terminal of a receiver and Input(1KHZ) in 

receiver of main controller with BNC Cable used for lm. 

4. Use below formula, calculate the length of Herical and measure the actual length of Herical 

then record in Table 8-1.The exact oscillation frequency of RF signal generator is 10GHz. 

 
Table 8-1 Length of Antenna [cm] 

 Theoretic Length of Antenna Actual Length of Antenna 

λ   

A To be Decided by Number of Antenna  

L   

D   

S   

5. As Figure 8-7,the distance between antennas is isolated as r=lm. Set the transmitting 

 receiving antennas at opposite position of same height. Make the center of a helix conductor 

of herical antenna and the center of square horn part of a horn antenna to place in straight 

line. 
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Figure 8-7  Distance between Antenna r 

6. Set as below in condition of turning off the power of main controller. 

   - Power OFF 

   - 500MHz Oscillation Switch off 

   - 2 GHz Oscillation Switch off 

   - 10 GHz Oscillation Switch off 

- Modulation Switch (Mod) off 

7.  After set a switch in main controller as below, execute the Antenna Trainer program. 

    - Power ON 

    - 500MHz Oscillation Switch off 

    - 2 GHz Oscillation Switch off 

    - 10 GHz Oscillation Switch on 

    - Modulation Switch (Mod) on 

 

8. The program window is executed, execute Data Acquisition in Pop Up menu. Here after select 

Antenna. select E-Plane as Plane and control to be displayed 0 in gain displayer hy  

adjusting the signal attenuation. The adjustnlent is  completed start Acquisition. 

 

9. If the data acquisition is completed, save the taken radial pattern in file. Use the data 

box to confirm a radial pattern exactly. If set MSP(Max. Signal Position) to 0°, can see 

the radial pattern of this antenna. 

 

10. Make the polarization control plate to rotate 90°for the 10GHz Horn antenna used for 

transmitting get a vertical polarization characteristic. 

 
 Figure 8-8 Rotation of Vertical Polarization Transmitting Antenna 

11. Fix to measure the axial mode radial characteristic of a Herical antenna. 
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12. Click Antenna Initialize in Edit Menu of a software, click the Auto button to data 

acquisition. 

 

13. Set again for the transmitting antenna get an even polarization characteristic and for 

receiving antennas get an axial mode radial characteristic. The distance between antennas 

is r=l.0m. Make a surrounding condition of antenna to be same as the first experiment. 

Take the axial mode radial pattern of a herical antenna and save in Dummy-Plane.    

Theoretically if except an effect caused by a power damage, this radial pattern has to 

be same as the first pattern. If the pattern is different very. much, have to do suitably 

by finding the position where a reflection can be occurred. After do suitably, continue 

an experiment and save new pattern in E-Plane. Click Data Indicating Line in View Menu 

of upper menu of a data analysis program. Two cursors(Blue, White) used for Axial 

Mode(E-Plane) and tow cursors(Yellow, Green) used for Normal Mode(H-Plane) are appeared 

on the screen. If click an arrow on both side of a displayer of each color, the values 

in the displayer will be changed by moving the cursor of same color. These indicate the 

angle of cursor position and the receiving power in that time as dB, show the difference 

of angle  between  cursors  and  power in  below  2 displayer. Record the values in 

below Table 8-2. 

Table 8-2 Receiving Power for Angle 

Angle 

 
0° 30

°
 60° 90° 120° 150° 180° 210° 240° 270° 300° 330° 

Receiving 

Power of 

E-Plane 

For Angle 

            

Receiving 

Power of 

H-Plane 

For Angle 

            

  

14. Use the cursor to take the receiving angle of max. power in Axial Mode and the receiving 

power in that time. Click the Maximum Single Level button on the axial mode(E-Plane) window 

to confirm if a measured value is accorded to a taken value with cursor. Record this in 

Table 8-3. 

 

15. Take a half angle of main beam power in axial mode pattern by using two cursors. Click 

the Half Power Beamwidth button on axial mode(E-Plane) data window to confirm if same 

the measured value with button as taken value with cursors. 

         Table 8-3  Comparison of E-Plane with Theoretic Value 

Receiving Power  Taken Value 

With cursor Angle  

Receiving Power  Value by Maximum  

Single Level Icom Angle  

Calculate a half-power beam width of a herical antenna in axial mode(E-Plane) with below 

formula. 

 

16. Repeat No. 15 of the experiment procedure in H-Plane radial pattern. 
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17. Delete all cursors by clicking the data indicating line in view menu. Compare the 

experimental values with given value in the antenna software. If the calculated result 

is not accorded to this values, experiment and calculate again.Save the E-Plane and H-Plane 

data and output the resuIt. 
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EXCERClSE 

1. Take the Axial ratio by substituting A, D, S, N in Table 8-1 to Formula 8-2. 

                                                                                     

                                                                                     

2. Take a gain by substituting A, D, S, N in Table 8-1 tb Formula 8-3. 

                                                                                     

                                                                                     

3. What's the circular polarization ? Arrange the type of polarization and explain  

the difference between each polarization. 

                                                                                     

                                                                                     

4. Explain the normal mode and axial mode of a herical antenna. 

                                                                                     

                                                                                     

                                                                                     

                                                                                     

 



 99 

EXPERIMENT3-9 EXP. OF HORN ANTENNA 

Let's measure the radial pattern for E-Plane and H-Plane of Horn antenna used for 10GHz in this 

experiment. We will study a radial pattern of a Horn antenna. Let's calculate a half-power beam 

width of a horn antenna. 

BASIC STUDY 

  9.1 Pyramidal Horn Antenna 
The pyramidal horn antenna is one type of antenna used very much. Figure 9-1 shows the geometry 

model. 

 

(A) Geometry Structure   (B) Section of H- Plane   (C) Section of E- Plane 

Figure 9-1 Pyramidal horn Antenna 

The waveguide can spread a shape of numerous modes of electron wave that is 3 dimension passing 

into waveguide. Each mode consists of unique own electron field. If the opening angle of a 

pyramidal antenna is small sufficiently, only the dominant mode of waveguide has a mean. Other 

modes can be spreaded by being evanescent mode. 

The flux line of main mode is expanded into the cylindrical type with a sector horn antenna, 

and into global type with a pyramidal horn antenna. Figure 9-2 shows the shape. 

 
Figure 9-2  Phase Error by Wave Front of Horn Antenna (A) 
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As above figure, the wave front is not plane but curved surface. This is the cause inducing 

the  phase  error,  can  be considered  in  analysis  of antenna characteristic. The phase 

error is indicated by generalized route error that is s and t. 

 

where s and t are generalized route error. 

A is wave 

A, B, Leand LH are values given in Figure 9-1. 

The approximate gain of a pyramidal horn antenna can be calculated by Formula 9-3. 

 

where  Lz and Ln are a damage value by phase error caused by becoming open little by little, 

The fonnula indicated by dB is as below. 

 

The values of L E(dB) and L H(dB) can be taken if calculate s and t at first with formula 

9-1 and 9-2. 

 

9.2 Electric Wave Damage in Free Space 

The power received by antenna decrease according to far away from transmitting antenna. In 

free space, the receiving signal power is in inverse proportion to the square of distance 

between a transmitting antenna and receiving antenna. The power damage caused by an isolated  

distance between antennas is called the electric wave damage L F. If show the electric wave 

damage on the free space by mathematic formula, becomes  

 
where r is a distance between antennas 

   λis an electric wave period in a free space (same unit as r). 

For given wave, formula 9-5 shows that L F is changed by only distance between antennas.  

This relational expression can be taken experimentally as measure the receiving power from 

antennas placed in other distance with transmitted signal from some antenna. 

However must maintain the direction between two antennas during experiment since the antennas  

have a directivity generally. If can know the isolated distance between antennas, can calculate 

the power attenuation between receiving power in optional distance and in other distance.The 

numerical formula indicating this is 

 

where A is a damage indicated by dB 

      r1 and r2 are distance between the first antenna and second antenna. 

To decide a direction characteristic of an antenna numerically, the concept of directivity 
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or direction gain is used generally. The directivity is max. radial intensity toward given 

direction for the average radial intensity. The isotropic antenna radiating an identical power 

toward all direction, that is in ideal antenna, the antenna gain(direction gain) equal to 

directivity. 

 

9.3 Measuring Gain of Antenna 

Of various method to measure a gain of antenna, as the most thing is a method of reference  

antenna(compare method or substitute method), this is method comparing the receiving power 

of a reference antenna  PRef and of a test antenna PTest mutually. The gain of a test antenna 

can be indicated by Formula 9-7. 

 
Indicate by dB, becomes as below. 

 

Before use a substitution method, must do calibration the reference antenna. One thing of 

the method is what use two same antenna. If the transmitting receiving power, the gain can 

be calculated with Formula 9-9. 

 

Where, 

   G is gain 

   r is distance between antennas 

   Po and PRec are transmitting receiving power respectively 

   λ is wave in free space(same unit as r ). 
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EXPERIMENT PROCEDURE 

1. Set a transmitting, receiving antenna positioner and a computer which are main instrument 

of an antenna experimental set. 

 

2. Fix 10GHz Horn antenna on the polarization control plate in transmitter. Set it to be even 

with earth to get an even polarization characteristic. The transmitting Horn antenna set 

as Figure 9-3 gets an even polarization characteristic. Connect 10GHz oscillation output 

terminal in main controller and Cable connecting terminal of Horn antenna with SMA cable 

used for 2m. 

 

Figure 9-3  Setting of Even Polarization Horn Antenna 

3. Fix the Horn antenna on the polarization control plate in receiver to get an even 

   polarization characteristic at vertical position with earth, Place the antenna in rotary 

 center of receiver by using the position control plate. See Figure 9--4 to set. 

   

Figure 9-4 Even Polarization Receiving Antenna 

Connect the Horn antenna and RF In terminal of a receiver with SMA cable used  for  lm,  and 

connect OUT PUT(1KHz) terminal of a receiver and Input(1KHZ) in receiver of main controller 

with BNC Cable used for lm. 
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4. Measure the length of a 10GHz Horn antenna in Figure 9-1 and record in Table 9-1. 

Table 9-1 Length of Antenna [cm] 

 
 

 

 

 

 

 

 

 

5. As Figure 9-5, the distance between antennas is isolated as r=lm. Place the transmitting    

receiving antenna on opposite position of same height. 

 

                        
Figure 9-5 Distance between Antenna r 

 

6. Set as below in condition of turning off the power of main controller. 

    - Power OFF 

    - 500MHz Oscillation Switch off 

    - 2 GHz Oscillation Switch off 

    - 10 GHz Oscillation Switch off 

    - Modulation Switch (Mod) off 

 

7. After set a switch in main controller as below, execute the Antenna Trainer program. 

    - Power ON 

    - 500MHz Oscillation Switch off 

    - 2 GHz  Oscillation Switch off 

   - 10 GHz Oscillation Switch on 

   - Modulation Switch (Mod) on 

 

8. The program window is executed, execute Data Acquisition in Pop Up menu. Here after select 

Antenna, select E-Plane as Plane and control to be displayed 0 in gain displayer by adjusting 

   the signal attenuation. The adjustment is completed, start Acquisition. 

 

9. If the data acquisition is completed, save the taken radial pattern in file. Use the data 

 Actual Antenna Length 

a  

b  

A  

B  

LE  

RE  

LH  

RH  
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box to confirm a radial pattern exactly. If set MSP(Max. Signal Position) to 0°, can see  

the radial pattern of this antenna. 

 

10. Make the control plate to rotate 90" for the 10GHz  Horn antenna used for transmitting get 

a vertical polarization characteristic. 

 
Figure 9-6 Setting of Horn Antenna 

11. Set the Horn antenna used for receiving as Figure 9-6 to get a vertical polarization 

characteristic. 

 

12. Click Antenna Initialize in Edit Menu of a software, click the Auto button to data acquisition. 

If the data acquisition is finished, after select H-Plane as Plane, save the pattern in file. 

 

13. Keep the 10GHz  Horn antenna used for transmitting  to  get a vertical polarization 

characteristic and set the horn antenna used for receiving to get a vertical polarization 

characteristic. 

 

14. Click Antenna Initialize in Edit Menu of software, and click again Delete Screen then click 

the Auto button to data acquisition. 

 

15. Observe three radial pattern. 

 

16.Set a transmitting receiving antennas get a vertical polarization characteristic 

respectively. The distance between antennas is r=l.0m. Make a surrounding condition of 

antenna to be same as the first experiment. Take the E-Plane radial pattern of a horn antenna 

and save in Dummy-Plane.  

Theoretically if except an effect caused by a power damage, this radial pattern has to be 

same as the first pattern. If the pattern is different very much, have to do suitably by 

finding the position where a reflection can be occurred. After do suitably, continue an 

experiment and save new pattern in E-Plane. Click Data Indicating Line in View Menu of upper 

menu of a data analysis program. Two cursors (Blue, White) used for E-Plane and tow cursors 

(Yellow, Green) used for H-Plane are appeared on the screen. If click an arrow on both side 

of a displayer of each color, the values in the displayer will be changed by moving 

the cursor of same color. These indicate the angle of cursor position and the receiving power 
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in that time as dB, show the difference of angle between  cursors and power in below 2 

displayer. Record the values in below Table 9-2. 

Table 9-2 Receiving Power for Angle 

Angle 

 
0° 30

°
 60° 90° 120° 150° 180° 210° 240° 270° 300° 330° 

Receiving 

Power of 

E-Plane 

For Angle 

            

Receiving 

Power of 

H-Plane 

For Angle 

            

17. Use the cursor to take the receiving angle of max. power in E-Plane pattern and the receiving 

power in that time. Click the Maximum Single Level button on the E-Plane data window to 

confirm if a measured value is accorded to a taken value with cursor. Record this in Table 

9-3. 

Table 9-3 Comparison of E-Plane with Theoretic Value 

Receiving Power  Taken Value 

With cursor Angle  

Receiving Power  Value by Maximum  

Single Level Icon Angle  

 

18. Take a half angle of main beam power in E-Plane pattern by using two cursors. Click the 

Half Power Beamwidth button on data window to confirm if accord the measured value with 

button as taken value with cursor. Calculate a half-power beam width of horn antenna in 

E-Plane with below formula. 

 

19. Repeat No.18 of the experiment procedure in H-Plane radial pattern. 

 

20. Delete all cursors by clicking the data indicating line in view menu, Compare the 

experimental values with given value in the antenna software. If the calculated result is 

not accorded to this values, experiment and calculate again. 

 

21. Save the E-Plane and H-Plane data and output the result. 



 106 

EXCERClSE 

1. When make the isolated distance of antenna to be 2times in Figure 9-4, how dB is decreased ? 

                                                                                          

                                                                                                        

2. Explain the effect caused by the opening angle of a pyramidal horn antenna. 

                                                                                          

                                                                                            

3. Explain what's the shape similar to the radial pattern of a pyramidal horn antenna. 

                                                                                          

                                                                                            

4. Take the gain of antenna with numerical formula and experiment, and explain the difference. 

                                                                                          

                                                                                            

5. What's the radial pattern of a Horn antenna? 
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EXPERIMENT3-10 SINGLE PATCH ANTENNA 

Let's measure a radial pattern for E-Plane and H-Plane of a single patch antenna in this 

experiment. We will study the radial characteristic of a single patch antenna. Let's calculate 

a half-wave beam width of a single patch antenna by using the antenna software. 

 

BASIC STUDY 

 1. Characteristic of Square Patch Antenna 

 

Figure 10-1 Basic Square Microstrip Antenna 

Figure 10-1 shows the size of a basic square microstrip patch antenna. The conductance of 

antenna is a function of width a, and the resonance frequency is a function of length b. The 

length b is given as below.  

 

Where λd is a wave in a dielectric substance 

        λ0 is a wave in a free space 

        εr is a relative dielectric constant of a base material 

Because the change of dielectric constant and feed inductance, it is necessary to identify 

the exact length of patch when measure. 

 

Figure 10-2 shows the current flowing into patch and the field around it. The field is on 

the edge of patch connected with feeder mainly and is on opposite edge. This field caused 

by a radial characteristic of antenna .The wave radiated from antenna get an even polarization 

characteristic as Figure10-2. That is the even direction is E-Plane(x-y plane), and the 

vertical direction is H-Plane(y-z plane). 

The b, spacing between two edge of a patch antenna is about length(0.49λd) of half-wave in 

the dielectric substance. This is a reason that the opposite slot becomes an antenna exciting 

to the inverse phase. But the field radiating to two parallel slot becomes add to same phase 

in direction of broadside(that is direction of y) of antenna. 
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Figure 10-2 Current Distribution and Main Type of Field 

 

2. Radial Pattern in case of two slots is distributed 

One analogy to calculate the characteristic of square patch antenna simply and clearly is 

what compare the patch antenna in Figure 10--1 with the waveguide slot antenna taking 2-slot 

in Figure 10-3.Since the 2-slot waveguide slot antenna in Figure 10-3 is equal to the patch 

antenna in Figure 10-3, two radial pattern is appeared identically. 

To understand the radial pattern of 2-slot waveguide antenna, pay attention to what select 

distance b for the field radiated from both slot becomes same phase as Figure 10-4. The distance 

between each slot becomes same at any point on y axis. 

 

Figure 10-3 Two Parallel Slot in Waveguide 

Therefore the field caused by two slot becomes radiate maximally since to be added by becoming 

same phase. In other direction, it is not added completely as same phase for the distance 

between two slots is different. Accordingly the radial pattern will be get a main lobe, maximum  

size at direction of y axis. 
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Figure 10-4 Analysis of E-Plane Far-Field in Square Patch 

Figure 10-4 shows the picture drawing one slot by 3 dimensions. In this figure, axis and each 

Ф,θare used as a variable number of basic formula, a and b in Formula 10-2 and 10-3 is a 

related value to the width a and length b of patch in Figure 10-4. 

The height h in Figure 10-4 is a value related to the thickness of base material of dielectric 

substance in Figure 10-1 and 10-2. 

The radial pattern of E-Plane for two slots excited by same amplitude and phase is given as 

below formula. 

 

Where h is a height of slot(same as the thickness of antenna base material) 

b is a distance between two slots(same as the length of patch antenna) 

 

 

 Figure10-5 Type for Calculation of E -, H - Plane Radial Pattern 

The H-Plane pattern is given as below. 
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Where, a is a length of slot. 

Theoretically, E-Plane pattern and H-Plane pattern have to be appeared as Figure 10-5. 

 

3. Input Impedance of Microstrip Antenna 

As the input impedance of 2-slot array antenna and λ/2 square patch antenna is a resistant 

element(Reactance element"0"), have a good radial characteristic. The approximate value of 

an input resistance is as below. 

 

Where a is a length of slot 

       λ0 is a wave in free space 

 

Figure 10-6 Theoretic E-, H-Plane Radial Pattern for two slots excited to 

                     Same Phase with Same Size(b= λd/2, where λd<λ ) 

Theoretically as the input impedance of patch is about 120Ω, the impedance of a microstrip 

line and input unit of coaxial cable must be 120Ω. But to connect with the 50Ωcoaxial cable 

using in experiment set for antenna, the 50Ω microstrip line is used. 

To match the impedance between 50Ω microstrip line and 120Ω patch, use the λ/4 impedance 

inverter as Figure 10-7. The λ/4 impedance inverter is a useful technique for the impedance  

matching  in  narrow  band. The characteristic impedance ZL of λ/4  impedance inverter to 

match Z1 and Z2 is as below. 

 

 

Figure 10-7 λ/4 of Impedance ZL for matching impedance Z1. Z2 

  Z1 is an impedance of a coaxial cable or microstrip line taking 50Ω, if Z2 is an impedance 

of a patch antenna, the characteristic impedance of ,λ/4 impedance inverter connected to 

patch and microstrip is as below. 
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Figure 10-8 shows the sigle patch antenna in antenna set and λ/4 impedance inverter of 

78Ω. 

 

Figure 10-8 Single Patch Antenna (Unit: mm) 
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EXPERIMENT PROCEDURE 

1. Set a transmitting-receiving antenna posltioner and a computer which are main instrument 

of an antenna experimental set. 

2. Fix 10GHz Horn antenna on the polarization control plate in transmitter. Set it to be even 

with earth to get an even polarization characteristic. The transmitting Horn antenna as Figure 

10-9 gets an even polarization characteristic. Connect 10GHz oscillation output terminal in 

main controller and Cable connecting terminal of Horn antenna with SMA cable used for 2m. 

 

Figure 10-9 an even polarization characteristic  

3. Fix the Horn antenna on the polarization control plate in receiver to measure an axial mode 

radial characteristic. Use the position control screw in receiver; place the ground plane 

to be vertical with a rotary axis in receiver. See Figure 10-10 to set. 

 

Figure 10-10 Setting of Even Polarization Receiving Antenna 

Connect the single patch antenna and RF In terminal of a receiver with SMA cable used for 

lm, and connect OUT PUT(lKHz) terminal of a receiver and Input(lKHZ) in receiver of main 

controller with t3NC Cable used for lm. 

4. Measure the length of a single patch antenna and record in Table 10-1. 

 

 



 113 

Table 10-1 Length of Antenna [mm] 

 

 

 

 

 

 

5. As Figure 10-11, the distance between antennas is isolated as r=lm. Set the horn antenna 

used for transmitting and the single patch antenna used fox- receiving at even position with 

earth. Make the center of a front part(Horn Part) of horn antenna and the center of a single 

patch antenna to place in straight line. 

 
Figure 10-11 Distance between Antennas r 

6. Set as below in condition of turning off the power of main controller. 

    - Power OFF 

    - 500MHz Oscillation Switch off 

    - 2 GHz Oscillation Switch off 

    - 10 GHz Oscillation Switch off 

    - Modulation Switch (Mod) off 

 

7. After set a switch in main controller as below, execute the Antenna Trainer  program. 

    - Power ON 

    - 500MHz Oscillation Switch off 

    - 2 GHz Oscillation Switch off 

    - 10 GHz Oscillation Switch on 

    - Modulation Switch (Mod) on 

 

8. The program window is executed, execute Data Acquisition in Pop Up menu. 

Here after select Antenna, select E-Plane as Plane and control to be displayed 0 in gain 

displayer by adjusting the signal attenuation. The adjustment is completed, start 

Acquisition. 

 

9. If the data acquisition is completed, save the taken radial pattern in file. Use the data 

box to confirm a radial pattern exactly. If set MSP(Max. Signal Position) to 0°, can see 

the radial pattern of this antenna. 

10. Make the control plate to rotate 90~ for the Horn antenna is to be vertical with earth. 

 Actual Length of Antenna 

λ/2  

a  

b  

t  
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11. Make the single patch antenna used for receiving to be vertical with a rotary axis and set 

as Figure 10-12 to get a vertical polarization characteristic. In this time make the center 

point of front horn and the center of antenna used for receiving to be in straight line. 

 

Figure 10-12 Setting of Single Patch Antenna 

 

12. Click Antenna Initialize in Edit Menu of a software, click the Auto button to data acquisition. 

If the data acquisition is finished, after select H-Plane as Plane,save the pattern in file. 

 

13. Keep the Horn antenna used for transmitting to get a vertical polarization characteristic 

and set the horn antenna used for receiving to get a vertical polarization characteristic 

as Figure10-10. 

 

14. Click Antenna Initialize in Edit Menu of software, and click again Delete Screen then click 

the Auto button to data acquisition. 

 

15. Observe three radial pattern. 

 

16. Set a transmitting-receiving antennas get a vertical polarization characteristic 

    respectively. The distance between antennas is r=l.0m. Make a surrounding condition of 

antenna to be same as the first experiment. Take the E-Plane radial pattern of a single 

patch antenna and save in Dummy-Plane. 

 

Theoretically if except an effect caused by a power damage, this radial pattern has to be 

same as the first pattern. If the pattern is different very much, have to do suitably by 

finding the position where a reflection can be occurred. After do suitably, continue an 

experiment and save new pattern in E-Plane. 

 

Click Data Indicating Line in View Menu of upper menu of a data analysis program. Two  

Cursors (Blue, White) used for E-Plane and tow cursors(Yellow, Green) used for H-Plane are 

appeared on the screen. If click an arrow on both side of a displayer of each color, the 

values in the displayer will be changed by moving the cursor of same color. These indicate 

the angle of cursor position and the receiving power in that time as dB, show the difference 
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of angle between cursors and power in below 2 displayer. Record the values in below Table  

10-2. 

Table I0 2 Receiving Power for Angle 

Angle 

 
0° 30

°
 60° 90° 120° 150° 180° 210° 240° 270° 300° 330° 

Receiving 

Power of 

E-Plane 

For Angle 

            

Receiving 

Power of 

H-Plane 

For Angle 

            

 

17. Use the cursor to take the receiving angle of max. power in E-Plane pattern and the receiving 

power in that time. Click the Maximum Single Level button on the E-Plane data window to 

confirm if a measured value is accorded to a taken value with cursor. Record this in Table 

10-3. 

Table 10-3 Comparison of E-Plane with Theoric Value 

Receiving Power  Taken Value 

With cursor Angle  

Receiving Power  Value by Maximum  

Single Level Icon Angle  

 

18. Take a half angle of main beam power in E-Plane pattern by using two cursors. Click the 

Half Power Beamwidth button on data window to confirm if accord the measured value with 

button as taken value with cursor. 

Calculate a half-power beam width of single patch antenna in E-Plane. 

 

19. Repeat No. 18 of the experiment procedure in H-Plane radial pattern. 

 

20. Delete all cursors by clicking the data indicating line in view menu. Compare the experimental  

values with given value in the antenna software. If the calculated result is not accorded 

to this values，experiment and calculate again. 

 

21. Save the E-Plane and H-Plane data and output the result. 
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EXCERClSE 

l. Mean to feed to the microstrip patch antenna of 120$2 input impedance with a coaxial cable 

  of Ω characteristic impedance. In this case, design λ/4 impdance inverter by 2 position. 

                                                                                            

                                                                                            

2. In Figure 10-1, decide a and b of a square microstrip patch antenna used for 2.4 GHz. 

                                                                                            

                                                                                            

3. Compare and explain the radial pattern of a microstrip patch antenna and a horn antenna. 

                                                                                            

                                                                                            

4. Take a gain of a single patch antenna. 

                                                                                            

                                                                                            

5. What's the polarization characteristic of a single patch antenna ？ 

                                                                                            

                                                                                            

                                                                                            

                                                                                            

 

 



 117 

EXPERIMENT3-11 2 DIMENSION ARRAY ANTENNA 

Let's measure the radial pattern for E-Plane and H-Plane of 2 dimension array antenna. We will 

study the polarization characteristic of a 2dimension array antenna. Let's calculate a 

half-power beam width of a 2 dimension array antenna. 

 

BASIC STUDY 

1. Microstrip Plane Array Antenna 

As the array element is a parameter giving an effect on radial pattern of an antenna of special 

array structure, the entire radial pattern of given array antenna can be forecasted by the 

principle of pattern multiplication. Where the pattern multiplication is means what multiply 

the radial pattern of individual antenna element by the array element. 

As the square microstrip antenna and the 2-slot waveguide antenna is equivalent each other, 

the radial pattern is same. 

The E-Plane radial pattern for a 2-slot antenna excited to same phase and equal amplitude 

made of multiplying the E-Plane radial pattern of a 1-slot antenna by the array element for 

two elements. Accordingly this formula is as below. 

 

where 

h is a width of slot(same as a base material thickness of a patch antenna) 

b is a distance between two slots(same as length of a patch antenna) 

 

1.1 Serial Array and Parallel Array 

The square patch antenna is used as basic element of a microstrip array antenna. In this time, 

we will treat two type of array(Plane array antenna of type of parallel feed and serial feed) 

The microstrip array antenna consists of some microstrip antenna elements and microstrip feed 

circuit. The feed circuit consists of the manual elements such as power distributor and 

transmitting line as well as the active elements such as phase shifter, amplifier, launcher 

and frequency mixer etc. The feed line is connected to the radial element directly, and give 

not an effect on the radial pattern directly. 

The best merits of a microstrip antenna is what can etch the arrayed antenna on one base material 

as well as feed line. That is, can contain various elements to antenna with low price. The array 

antenna is very thin and can contain numerous elements so it can achieve to high effect. 

The other merits of array antenna is a reliability. As it is manufactured by etching the copper 

panel, becomes the least of all the problem on manufacturing such as open or short-circuit. 

But the array antenna using a patch antenna has very narrow band of using frequency so it can 

be used only in band given exactly. 

The microstrip array antenna of parallel feed type is what feed with parallel to give suitable 

phase to each element. But to make main beam at vertical position with plane of arrayed antenna, 
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generally feeding with same phase. 

 
Figure 11-1 Microstrip Patch Array 

To  make  the phase  of current  feeding  to  each  element,  must  array  the transmitting 

line and antenna elements to be symmetry. The structure like tree called cooperate feed is used 

generally to transmit the power with same phase. 

But it can be occurred the problem on designed space when there are many elements. If use numerous 

matching element called λ/4 inverter, can match exactly all radial elements to 50Ω feeding 

to antenna as Figure 11-1. 

It is possible to connect the array element with serial. It may be efficient well but the serial 

feed type is complex to design in compared with parallel feed type caused by the dependent 

relation between each element. The element of each patch antenna is had to be seen equivalent 

value to 2-slot antenna, and had to be considered the mutual coupling effect between patchs 

for calculation.  

In the case of parallel feed array antenna, if increase the number of element to 2 times,the 

increasing  of gain can be forecasted  becomes restricted by feed damage. This damage is 

occurred by coupling of inductance and capacity between numerous feed line. In case of serial 

feed antenna, the connection between patchs is linear accordingly the problem becomes few 

relatively. 

This two type can be coupled by serial" parallel array taken merit of two feed type. As the 

numerous small serial arrays connect with parallel, it is possible to make the feed circuit 

to be simple and to design large sized array antenna decreasing power damage. 
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EXPERIMENT PROCEDURE 

l. Set a transmitting-receiving antenna positioner and a computer which are main instrument 

of an antenna experimental set. 

 

2. Fix 10GHz Horn antenna on the polarization control plate in transmitter. Set it to be even 

with earth to get an even polarization characteristic. The transmitting Horn antenna as 

Figure 11-2 gets an even polarization characteristic. 

Connect 10GHz oscillation output terminal in main controller and Cable connecting terminal 

of Horn antenna with SMA cable used for 2m. 

 

Figure 11-2 An even polarization characteristic 

3. Fix the 2 dimension array antenna on the polarization control plate in receiver to measure 

 an axial mode radial characteristic. Use the position control screw in receiver, place the 

 ground plane to be vertical with a rotary axis in receiver. See Figure ll-3 to set. 

 

Figure 11-3 Setting of Even Polarization Receiving Antenna 

Connect the 2 dimension array antenna and RF In terminal of a receiver with SMA cable used  

for lm, and connect OUT PUT(1KHz) terminal of a receiver and Input(1KHZ) in receiver of main 

Controller with BNC Cable used for lm. 

 

4. Measure the length of a 2 dimension array antenna and record in Table 11-1. 
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Table 11-1  Length of Antenna and Feeder[mm] 

 Length of Antenna  

λ/2  

a  

b  

 

5. As Figure 11-3, the distance between antennas is isolated as r=lm. Set the horn antenna used 

for transmitting and the single patch antenna used for receiving at to be even and opposite 

each other. Make the center of a front part(Horn Part) of horn antenna and the center of a 

single patch antenna to place in straight line. 

 

Figure 11-4 Distance between Antennas r 

6. Set as below in condition of turning off the power of main controller. 

    - Power OFF 

    - 500MHz Oscillation Switch off 

    - 2 GHz Oscillation Switch off 

    - 10 GHz Oscillation Switch off 

    - Modulation Switch (Mod) off 

 

7. After set a switch in mare controller as below, execute the Antenna Trainer program. 

   - Power ON 

   - 500Mttz Oscillation Switch off 

   - 2 GHz Oscillation Switch off 

   - 10 GHz Oscillation Switch on 

   - Modulation Switch (Mod) on 

 

8. The progranl window is executed, execute l)ata Acquisition in Pop Up menu.  

Here after select Antenna, select l:.-Plane as Plane and control to be displayed 0 in gain 

displayer by adjusting the signal attenuation.  the adjustment is completed,start  

Acquisition. 

 

9. If the data acquisition is completed, save the taken radial pattern in file. Use the data 

 box to confirm a radial pattern exactly. If set MSP(Max. Signal Position) to 0°, can see 

 the radial pattern of this antenna. 

10. Make the control plate to rotate 90°for the Horn antenna is to be vertical with earth. 
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11. Make the 2 dimension array antenna used for receiving to be vertical with a rotary axis 

and set as Figure 11-5 to get a vertical polarization characteristic. In this time make 

the center point of front horn and the center of antenna used for receiving to be in straight 

line. 

 

12. Click Antenna Initialize in Edit Menu of a software, click the Auto button to data acquisition. 

If the data acquisition is finished, after select H-Plane as Plane,save the pattern in file. 

 

Figure 11-5 Setting of 2 dimension array antenna 

13. Keep the Horn antenna used for transmitting to get a vertical polarization characteristic 

and set the 2 dimension array antenna used for receiving to get a vertical polarization 

characteristic. In this time, make transmitting and receiving antenna to be opposite 

position and Make the center of a front horn part of transmitting antenna and the center 

of receiving antenna to place in straight line. 

 

Figure 11-6 Vertical and Ever Antenna 

 

14. Click Antenna Initialize in Edit Menu of software, and click again Delete Screen then 

lick the Auto button to data acquisition. 

 

15. Observe three radial pattern. 

 

16. Set a transmitting receiving antennas get a vertical polarization characteristic 

respectively. The distance between antennas is r=l.0m. Make a surrounding condition of  

antenna to be same as the first experiment. Take the E-Plane radial pattern of 2 dimension  
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array antenna and save in Dummy-Plane. 

Theoretically if except an effect caused by a power damage, this radial pattern has to be 

same as the first pattern. If the pattern is different very much, have to do suitably by 

finding the position where a reflection can be occurred. After do suitably, continue an  

experiment and save new pattern in E-Plane. 

Click Data Indicating Line in View Menu of upper menu of a data analysis program. Two 

Cursors（Blue,White) used for E-Plane and tow cursors(Yellow,Green) used for H-Plane are 

appeared on the screen. If click an arrow on both side of a displayer of each color, the 

values in the displayer will be changed by moving the cursor of same color. These indicate  

the angle of cursor position and the receiving power in that time as dB, show the difference 

of angle between cursors and power in below 2 displayer. Record the values in below Table 

11-2. 

Table 1 1-.2  Receiving Power for Angle 

Angle 

 
0° 30

°
 60° 90° 120° 150° 180° 210° 240° 270° 300° 330° 

Receiving 

Power of 

E-Plane 

For Angle 

            

Receiving 

Power of 

H-Plane 

For Angle 

            

 

17. Use the cursor to take the receiving angle of max. power in E-Plane pattern and the receiving 

power in that time. Click the Maximum Single Level button on the E-Plane data window to 

confirm if a measured value is accorded to a taken value with cursor. Record this in Table 

11-3. 

Table 11-3  Comparison of E-Plane with Theoretic Value 

Receiving Power  Taken Value 

With cursor Angle  

Receiving Power  Value by Maximum  

Single Level Icon Angle  

 

18. Take a half angle of main beam power in E-Plane pattern by using two cursors. Click the  

Half Power Beamwidth button on data window to confirm if accord the measured value with  

button as taken value with cursor. 

Calculate a half-power beam width of 2 dimension array antenna in E Plane. 

 

 

19. Repeat No. 18 of the experiment procedure in H-Plane radial pattern. 

 

20. Delete all cursors by clicking the data indicating line in view menu. Compare the experimental 

values with given value in the antenna software. If the calculated result is not accorded  

to this values, experiment and calculate again. 
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21.Save the E-Plane and H-Plane data and output the result. 
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EXCERCISE 

1. Means to array four microstrip patch antenna of 120Ω input impedance, and to feed with a  

coaxial cable of 5Ω characteristic impedance. In this case, design λ/4 impedance inverter 

by 3 position. 

                                                                                           

                                                                                           

2. Draw 2 dimension lay out m case of arraying 16 microstrip patch antenna used for 10 GHz. 

                                                                                         

                                                                                         

3. Compare and explain the radial pattern of single microstnp antenna and 2 dimenstion array 

 antenna. 

                                                                                         

                                                                                         

4. Take a gain of a microstrip antenna arraying by 2 dimension the 8 microstfip patch antenna 

 used for 10 GHz. 

                                                                                         

                                                                                         

5. What′s the polarization characteristic of a 2 dimension array antenna？ 
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EXPERIMENT3-12 CIRCLE ARRANGING ANTENNA 

Let's measure radiation pattern about E-Plane and H-Plane of circle arranging antenna this 

experiment. We'll study polarization characteristic of circle arranging antenna. Using software, 

let's calculate half-power beam width of circle arranging antenna. 

 

BASIC STUDY 

1. Array Factor 

  Let's consider the case that each element is arranged linearly like d equally as seen figure12-1, 

for examine calculating method of arranging factor of antenna.In case of receiving far electron 

magnetic field on the transversal planeθ= 0, distance between signaler and each element is 

essentially identified. Thus current supplied to elements is added exactly the same phase. 

 

Figure 12-1 4-Element Linear Array 

Figure12-1, when θ>0, according to moving right element into left element, each element is  

far from signaler as d sinθthan fore element. This reason makes phase of current supplied 

to each element different. Phase difference Ψ is given by: 

 

Array factor(AF) for linear arranging made up of N piece element is written: 

 

In above formula, phase factor e
j(N-l)Ψ/2 indicates phase difference between the phase center 

and the starting point. Omitting this phase factor, it is given by: 

                                                                                                                                 
When Ψ=0, A0N is the maximum value,[it is easily got that unfold denominator, numerator by 

power series and take limit toΨ]. Dividing formula 12-3 by maximum value, you can get the  

normalized array factor f(Ψ) of N element arranging antenna which is considered fixed space 

and identical value and phase center is located in the starting point. 
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FIGURE 12-2 (A) 4-Array Factor for Element Arranging 

(B) Radiation Pattern for d= λ/2 

Figure 12-2(A) gives normalized array factor. This figure represents answer of arranging 

antenna as function of phase difference Ψ between elements near arranging antenna. When the  

phase difference is 0,i，e. when signalling power is located on the broadside, answer is 

the maximum. Figure 12-2(B) used diagrammatic method which indicates radiation pattern of 

antenna by polar coordinate. Figure is described half-circle which radius is βd. For example, 

when the interval of element is λ/2, the radius becomes 

 

After drawing half-circle, from each points in the figure which indicate array factor by figure 

to the half-circle draw a vertical line down. From the crossings between each vertical line 

and half-circle to the starting point of the circle draw another lines down. Then, along this 

segments of the lines, you make a point selecting points part from the starting points as 

same length as width of the array factor. For example, when Ψ= л/2, array factor is 0, so  

in the polar coordinate, point corresponding to it is the starting point. Array factor between 

Ψ=л/2 and Ψ=лis the maximum. This is identical with maximum value in the polar coordinate. 

 

2. SINGLE CIRCLE ARRANGING 

Generally, linear arranging antenna is easy array of element and making of feeder. But in 

the H-Plane and E-Plane, in order to design identically type of beam, the number of element 

always must be multiplied double for one line, because of this, it has a fault that area required 

becomes greater. 

Circle arranging antenna which antenna structure is symmetrical on the angle can realize high 

benefit antenna as arranging many antenna on the small area. 

Moreover circle arranging antenna by non-linear arranging has a merit which can get a radiation 

pattern of Taylor water supply type. 

Like figure 12-3, field of circle arranging antenna which isotropic element with N quantity 

on the x-y plane as the same space is located along the circle with radius a is given: 
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FIGURE 12-3 N-Circle Arranging Structure 

Rn is the distance from the n-th element to the-observing point. At the observing point, 

field is given as the following formula: 

 

In amplitude of current excited to the n-th element 

Фn  angle of n-th element on the x-y plane 

аn  phase of current excited to the *z-th element 

indicates isotropic element, if it is assumed that dimension and phase of current 

power feeding to each element of the single-circle arranging antenna with 2V quantity is equal, 

array factor can be written as follows: 

 

To make power feed by micro strip line the same phase, micro strip arranging antenna element 

must be an even number. Because feeder structure can be symmetrical. In case of single circle 

arranging, radiation pattern is widely affected by the element number of antenna and distance 

to the center point. 

 
FIGURE 12-4 Radiation Pattern Change of Circle Arranging Antenna 

                          According to the Isolated Distance Change ( Y-z plane) 
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FIGURE 12-5 Radiation Pattern Change According to 

the Circle Arranging Element Number Change (y-z plane) 

 

3. MEASUREMENT 

Measurement equipment and system used in order to measure characteristics of the circle arranging 

antenna is like figure 12-1 and 12-6. 

 

FIGURE 12-6 Antenna Measuring System 

TABLE 12-1 Measuring Equipment 

Equipment Model Use 

Spectrum analyzer AT6060D Frequency sphere power analyzing 

Standard gain horn DGB-520 Standard gain providing 

To measure radiation pattern and gain of circle arranging antenna, the standard horn antenna 

having 8.4-12.6[GHz] frequency band and the Anechoic chamber etc. is used. And using network 

analyzer, measure the resonance frequency and the reflected loss. Measure received signal 

circling 360°antenna which will be measured at the l[m] distance from standard horn antenna. 

Figure 12-7 shows the gain according to the frequency of standard-gain horn antenna(DGB-520). 
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FIGURE 12-7 Standard Gain Horn Antenna (DGB-520) 

Figure 12-8 is the result that measure radiation pattern of single circle arranging 

antenna made of 8-elements.  

Operating frequency of antenna is 10[GHz],gain is 13.l[dBi],-3[dB] beam width is about ±

12°on the H-plane and about -14.5°～+12°on the E-plane. 

Also, maximum size of sub lobe represents -ll.4[dB] on the H-plane and -7.5[dB] on the E-plane. 

 
FIGURE 12-8 Radiation Pattern of Circle Arranging Antenna(8-element) 
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EXPERIMENT PROCEDURE 

1. Set main controller which is  main equipment of antenna experiment set receiving-transmitting 

antenna positioner and computer. 

 

2. Fix the 10GHz Horn antenna on the polarization controlling plate of transmitter. Set 

horizontally to the ground in order to have horizontal  polarization characteristics. Like  

figure 12-9, installed transmitting horn antenna bearthe character of horizontal 

polarization. Connect 500MHz launching output terminal of main controller and cable 

connecting terminal of horn antenna by SMA cable for 2m. 

 

FIGURE 12-9 Horizontal Polarization Transmitting Antenna 

 

3. Fix the two-dimensional arranging antenna on polarization controlling plate of receiver  

horizontally to the ground in order to bear the character of horizontal polarization. Place 

antenna on the circling center of antenna receiver using position controlling plate. Install  

referring figure 12-10. 

 

 

Figure 12-10 Installion of Horizontal Polarization Receiving Antenna 

Connect the cable connecting terminal of circle arranging antenna and RF IN terminal of  
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receiver by SMA cable for lm. And connect output(1KHz) terminal of receiver and receiving 

section input(1KHz) terminal of main controller by BNC cable for lm. 

 

4. Measure length of the circle arranging antenna and record on the table 12-1. 

TABLE 12-1  Length of antenna and feeder [mm] 

 Length of Antenna 

λ/2  

a  

b  

 

5. Like figure 12-11, distance between antennas is isolated by r=lm. Install the horn  antenna 

 for transmitting and the single patch antenna for receiving horizontally and to face each 

 other. At this time, put the front section(horn section) square center of horn antenna and  

the center of single patch antenna in 

   a straight line. 

 

Figure 12-11 Distance r Between Antenna  

6.Set like below，in the condition of power is off. 

     - Power off 

     - 500MHz launching switch off 

     - 2 GHz launching switch off 

     - 10 GHz launching switch off 

     - Modulating switch (Mod) off 

 

7. Execute the antenna trainer program, after setting switch in the main controller like below. 

    - Power source on 

    - 500MHz launching switch off 

    - 2 GHz launching switch off 

    - 10 GHz launching switch on 

    - Modulating switch (Mod) on 

 

8. After executing program window, execute data-gain in the pop up menu. After selecting antenna, 

select E-Plane and control in order to be indicated 0 on the antenna gain display window 

controlling signal attenuation. After control is finished, start data-gain. 

 

9. After data-gain is over, store obtained radiation pattern by file. Use data box in order 

to ensure correctly radiation pattern. Set MSP(maximum signal place) on 0°, and you can find 

out radiation pattern of this antenna. 
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10.Iet the polarization controlling plate circle 90°,for horn antenna have vertical 

   polarization character. 

 

Figure 12-12 Installation of circle arranging antenna 

 

11. Install like figure 12-12, for circle arranging antenna for receiving have vertical 

    polarization character. 

 

12. Click antenna initialization on the editing menu of software and gain the data putting Auto 

button. After finishing data-gain, select H-Plane and save the pattern in a file. 

 

13. Keep the horn antenna for transmitting in order to bear the character of vertical 

polarization and install the circle arranging antenna for receiving in order to bear the 

character of horizontal polarization to face each other. 

 

FIGURE 12-13  Vertical Horizontal Antenna 

 

14. Click antenna initialization on the editing menu of software, click screen deletion on the 

editing menu again and gain the data putting Auto button. 

 

15. Observe three radiation patterns. 

 

16. Install again each receiving & transmitting antenna in order to bear the character of 
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  horizontal polarization. Distance between antennas is r=l.0m.Identify the environment 

SUITounding antenna with first experiment. Get the E-Plane radiation pattern of circle 

arranging antenna and save in the Dummy-Plane. 

Theoretically, this radiation pattern must be equal with first pattern except effect by 

electric power loss. If the pattern is quite different, you must take proper measure finding 

place where radiation can occur. After taking proper measure, keep going experiment and  

save the new pattern in the E-plane. 

Click data indicating line on the view menu in the upper menu of data analysis program. 

Two cursors for E-plane(sky blue, white) and two cursors for H-plane(yellow, green) 

represent on tile screen. Click arrow being both sides to the displayer of each color, and 

values of displayer will be changed moving same color cursor. These indicate angle which 

cursor is located on and receiving electric power at that time in dt3. Also, they indicate 

angle between cursors and difference of electric power in two displayers below. Record values 

obtained at this time on the table 12-2 below. 

Table 12-2 Receiving electric power by angle 

Angle 

 
0° 30

°
 60° 90° 120° 150° 180° 210° 240° 270° 300° 330° 

Receiving 

Power of 

E-Plane 

For Angle 

            

Receiving 

Power of 

H-Plane 

For Angle 

            

 

17. Using cursor, get the angle and receiving electric power at that time being  received maximum  

electric power on the E-Plane pattern. Record on the table 12-3 that being identified value  

being measured putting Maximum Single Level button of E-Plane data window and value being 

obtained using cursor. 

TABLE 12-3 Receiving electric power, Comparison of angle 

Receiving Power  Taken Value 

With cursor Angle  

Receiving Power  Value by Maximum  

Single Level Icom Angle  

 

18. Using two cursors, get the angle being half of electric power magnitude of  main beam. Confirm  

that it is identical which value being measured putting Half Power Beam width button of 

E-Plane data window and value being obtained using cursor. Figure the half-electric power 

beam width on the E-Plane of circle arranging antenna. 

 

19. Repeat experiment order No. 18 by the radiation pattern of It-Plane. 

 

20. Eliminate all cursor clicMng data indicating line of view menu. Compare experiment values 

 with values being given in the antenna software. If the results of calculation isn't 

 identical with this values, experiment and figure again. 
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21. Save data of E-Plane and H-Plane and output result. 

 

 

EXERCISES 

1. Mean to power feed micro strip patch antenna 8 having input impedance 120°by coaxial cable 

 having characteristic impedance 50.Q on the circle arranging antenna. At this case, design 

λ/4 impedance converter for 4 position. 

                                                                                         

                                                                                                      

2. Draw layout in case of circle arranging the micro strip patch antenna 16 for 10 GHz. 

                                                                                         

                                                                                                       

3. Compare and explain that radiation patterns of the single micro strip patch antenna with 

 the circle arranging antenna. 

                                                                                          

                                                                                         

4. Get the gain of micro strip antenna which the micro strip patch antenna 16 for 10 GHz is 

 circle arranged. 

                                                                                         

                                                                                         

5. What is the polarization character of circle arranging micro strip antenna? 

                                                                                        

                                                                                           

                                                                                               

                                                                                              

 

 

 


